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Introduction 
 

The SmartTRAC Product has been modeled around well-known Windows 
applications and is designed to be straightforward to learn and remember.  
 
This documentation provides an overview of user functions in the system, and how to 
work through commonly used scenarios.  It is recommended that you become 
comfortable with basic operations then experiment with the tools at your own pace. 
Experimentation is recommended as the fastest way to becoming an experienced 
operator. 
 
The Track Explorer is a powerful and flexible tool for monitoring the activity of fleets of 
mobile units. Each mobile operator is fitted with an automatic location communicator 
so that its position and movement can be tracked on screen against a background 
map of your region.  
 
The Track Explorer window provides a comprehensive range of tools for working with 
the map and the mobiles. You can generate current and historical position data for 
mobiles of interest, and view animations of past tracks. Depending on your operator 
privileges the Track Explorer also allows you to modify mobile reporting rates and 
map characteristics. 
 
NOTE:  Throughout this document the terms unit and mobile are used 
interchangeably to refer to the mobile entities (vehicles, personnel or vessels) being 
tracked. 
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Starting SmartTRAC Workstation 
 

If SmartTRAC has not already been installed on you will need to do this first.   
 
To check, open the folder shown below from the [Start] menu.  If the "SmartTRAC" 
item is missing please refer to the final chapter Installing SmartTRAC.  After 
installation you can return to this point to begin using the product. 
 
To open SmartTRAC Workstation… 

 

 
 

Select the "SmartTRAC Explorer" item from the [Start] menu as shown.   
 

To open SmartTRAC more easily, you can create a shortcut on your desktop 
or TaskBar.  To do this;  

 
• Click on the "SmartTRAC Explorer" icon as shown above 

• Drag this onto either the Desktop or TaskBar.   

• The example below shows the SmartTRAC Workstation icon dragged 
to the immediate right of the windows "Start" menu for easy access. 

 
(Please note; some earlier Windows versions do not support this feature) 
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Logging On  

  

 
While SmartTRAC is loading, you may be presented with a Database 
Authentication dialog.   
 
NOTE: If you do not see this dialog, your SmartTRAC system is either 
configured to use your Windows Logon for all security, or you are using a 
single user standalone system. 
 
When this dialog is displayed you must enter the following: 
 
1. The Database Name.  This determines which SmartTRAC database you 

will be logged into.  Most organizations have only one SmartTRAC 
database, but in some cases separate databases are configured for 
training purposes or for each region/division.  If you are unsure which 
database name to use, contact your Systems Administrator. 

 
2. Your username will default to the same setting used during Windows NT 

or Windows 2000 logon.  In most cases this is also your SmartTRAC 
username.  If your Systems Administrator has assigned you a different 
username for SmartTRAC use, you will need to enter this instead. 

 
3. You must enter a password.  Depending on how your systems 

administrator has configured the SmartTRAC system this is usually the  
same as your Windows NT or Windows 2000 password.  If not, contact 
your systems administrator for further details on the correct Username & 
Password to use when logging into SmartTRAC. 

Selecting a Map Backdrop 
 

Once SmartTRAC has completed loading, you will be presented with the main Track 
Explorer window.   
 

1. If you have purchased product directly for Standalone use this will show 
information from the SmartTRAC Sample Database.   

 
2. If you are working in a multi-user system, your Systems Administrator will 

have configured a SmartTRAC database for use.  This will include 
information on your organization’s fleet.  

 
3. In either case; you now need to select a map Backdrop.  To do this; click 

the button on the toolbar. 
 

4. The Open Dialog is then displayed.  You can select any compatible 
mapping file for use with SmartTRAC.  Compatible files end with the 
extension "WOR" (Workspace) and contain data in the MapInfo 
Workspace Format.  When SmartTRAC installs; a very basic worldmap is 
present; this has the name "LAND.WOR".  If you do not have any specific 
mapping files, open "LAND.WOR". 
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5. When loading Map Files you may see the message "This Workspace is 

not Compatible with Track Explorer…".  If this occurs; copy the message 
down and pass to your Systems Administrator or Map Supplier.  Some 
Mapinfo Workspace files contain features not supported by SmartTRAC, 
and need to be slightly modified before they can be opened in Track 
Explorer. 

 
6. Once the Map has loaded, you will see a screen similar to the one below 

(the exact screen will depend on which database and map set you are 
using). 
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Track Explorer Program Window 
 

The Track Explorer program window includes the following components, which can be 
resized to suit your working preferences.  

Toolbar  

 
Mobile management tools and utilities are available in the toolbar below the 
menu bar. The toolbar contains four separate tool palettes, which are 
separated by vertical lines on the toolbar. 
 
The tool palette can be dragged away from the toolbar and on to the map 
window if required. To return a palette to the main toolbar just drag it or 
double-click the palette’s title bar. 
 
The available tools are as follows: 

 
Open Allows you to open a previously saved workspace into the 

program window. A saved workspace includes a view of 
the map with track presentation & label options. 

Save Allows you to save the contents of the map window exactly 
as they are (including map settings, and labels) so that 
they can be reviewed during a later session. 

Print If a printer is connected to this PC, you can use this option 
to print the displayed map and mobile information. 

Move This is a menu of tools for moving around the map 
Select This is a menu of tools for selecting mobiles displayed on 

the map and exporting data to other applications 
Analyze This is a menu of tools that allow you to make distance 

measurements, label information displayed on the map and 
show/hide various detail levels of information. 

Draw This is a menu of tools that allow you to add your own text 
and graphics to the map. Depending on your operator 
privileges you can save your graphics so that they are 
displayed every time you use the Track Explorer. 

Back Use this option to return to the previous view of the map. 
Stop Use this option to immediately cancel the current action; for 

example, loading a selection of mobiles. The Stop button 
immediately stops the activity but does not restore any 
previous settings. 

Date Bar This slide bar allows you to select a date range for 
historical analysis and animations.   Right click on this tool 
to see further menu options. 

 
 

Note: Only one tool from the above menus can be active at any one 
time; the active tool is highlighted on the menu bar.   For example; 
 
 
The [Move]Æ [Zoom-In] tool is selected. 
 
 
The [Analyze] Æ [Ruler] tool is selected.  
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Filter  
 

The Filter allows you to view and select mobiles of 
interest. It is operated in the same way as the 
Windows Explorer is used to select files and 
programs.  
 
Because Track Explorer is capable of monitoring several thousand mobiles, 
the available units are sorted into groups according to attributes such as their 
country of origin, type, and length. This allows you to locate a mobile of 
interest much more quickly than searching through the entire list.  
 
The available groups of mobiles are displayed at the first level of the Filter 
window; groups that have special icons are shared with other SmartTRAC 
users and cannot be changed, except by the system administrator. 
 
However, you can set up your own groups of frequently monitored units.  
These groups can be changed as often as you like. They are saved each time 
you exit Track Explorer so that they are available during future sessions by 
you and any other users connected to the same database. 

 
Within each group there are several categories, which further sub-divide the 
available mobiles (for example, one category for each unit type) . You can 
add and remove categories of mobiles in your personal groups as required 
(you cannot modify categories within shared groups). 
 

Unit List 
 
 
 
 

 
The unit list is displayed across the bottom of the map. It displays the mobile 
units that are currently available for display on the map.  
 
Under normal circumstances the unit list contains only a small number of the 
total mobiles in the system. This is because the Filter window is usually set up 
to sort and filter all mobiles so that only mobiles of interest are displayed.  
 
1. The exact list of columns depends on the database in use.  You may see 

a different selection of Mobile Attributes to those shown above. 

2. You can sort the list by any attribute.  To do this; click on the column 
heading.  You can also right click (anywhere in the unit list except directly 
on a mobile) and choose an [Arrange 
Icons by] option. 

3. You can simplify the view to icons 
only.  To do this right click (anywhere 
in the unit list except directly on a 
mobile) then select a [View] option. 

4. To jump quickly to a mobile if you know the short name (the first column) 
enter the first letter.  The list will then scroll to the appropriate point. 
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Map window 
 

Mobiles selected for tracking are displayed on the in 
the map window.  The positions are updated 
automatically whenever new reports are received.  
 
You can change the basic characteristics of the Map 
Window by right-clicking anywhere on the map and selecting one of the menu 
options.  The [Move], [Select], [Analyze] and [Draw] tools allow you to modify 
the presentation and configuration of the Map Window in more detail. 

 

Displaying Mobile Units 

Displaying Mobiles of Interest in the Unit List 
 

Use the groups and categories displayed in the filter window to change the 
contents of the unit list as follows: 
 

• Click on the All option to display all mobiles in 
the unit list 

• Click on a category to see only the mobiles in 
that category in the unit list 

• To list the members of more than one group 
or category press the [Ctrl] key then click on 
each group/category in turn. 

• If you select multiple folders within a group 
this means to show mobile units in all 
categories selected.  For example; selecting 
the types; Bus & Car will show any mobiles 
that are either Busses or Cars. 

• If you select multiple folders across categories; eg. Type="Vessels" 
and Country="Australia" then only mobile units where type "Vessel" 
AND with a country of "Australia" will be displayed in the unit list.  

Displaying a Unit on the Map 
 

You can display the current geographic location of mobiles on the map in 
several ways: 

 
• To show the current location of all mobiles in your 

fleet, ’drag-and-drop’ the [All] icon onto the map 
window. 

• To show a section of the fleet, ’drag-and-drop’ a category folder from 
the filter list directly onto the map window. 

• To show specific mobile units, first use the filter (as described above) 
to select part of the fleet.  Then use the Unit List (bottom of the 
window) and ‘drag-and-drop’ a specific mobile units from the mobile 
list onto the map window (or) 

• Double-click on the mobile in the unit list (or) 
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• Right-click on a mobile and choose the 

"Explore tracks" menu option 

 
The selected unit is displayed at its current 
location on the map, and replaces any 
previously displayed mobiles.  

 

Displaying multiple units 
 

To select multiple adjacent mobiles from the unit list: 
 

• Click and drag the pointer across 
the mobiles of interest (for example 
from top-left to bottom-right).  You 
will see a block of mobiles selected 
similar to the example shown.  

 
To select multiple mobiles at random: 

 
• Press the [Ctrl] key while clicking in 

turn on each unit of interest. You 
will see a block of mobiles selected 
similar to the example shown. 

 
When all units have been selected "drag-and-drop" the units to the map 
window, or right-click and choose the [Explore Tracks] option. The new 
mobiles replace any selection previously displayed on the map. 

 
If you want to select all mobiles in a particular group or category: 

 
• Drag-and-drop the folder of interest 

from the filter window to the map 
window. 

 
Displaying a group of mobiles is different from 
selecting the same mobiles individually.   The 
difference is best illustrated by an example.  If you select all busses in the 
sample database individually (from the unit list), then new mobile units were 
added to the fleet the map selection does not change.  It shows only the units 
that were specifically selected for display on the map. 
 
However, if you select the "Bus" folder, as shown above, then any new mobile 
units added of type "Bus" are automatically displayed (added) to the map.  
 
Displaying groups is particularly useful when the selected group represents a 
status attribute of the mobile (e.g. reporting rate, a digital input sensor such 
as door open/door close status).  For example some system configurations 
have mobile data terminals connected to the mobile unit.  These 
configurations include additional folders indicating mobile status such as 
on/off-duty, type of cargo or area of operation.   
 
By using the techniques illustrated it is then possible to monitor, for example, 
all off-duty vehicles.  As drivers change status through their mobile data 
terminals the map automatically changes to show the appropriate mobile 
units.  
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Viewing a Different Part of the Map 
 

The Move tools menu is used to navigate within the map window.  This 
includes zoom operations and selecting a specific map view based on known 
coordinates. 

 

Zooming In to the Map 
 

Select “Zoom In” from the Move tool menu.  
 

The shape of the pointer changes to indicate that the 
Zoom In tool is active.   While the Zoom In tool is active 
you can: 

 
• Enlarge a single point of interest by clicking the 

Zoom In pointer at that point on the map. This redraws the map at 
twice the scale and positions the selected point is at the centre of the 
map window. 

• Enlarge a region of interest by clicking and dragging the Zoom In 
pointer across (for example, from the top, left-hand side to the 
bottom, right-hand side of) the area of interest. This redraws the map 
so that the selected area of interest fills the map window. 

• Use a combination of these techniques to size the map as required. 
Switch to another tool when you’re finished with this tool. 

• NOTE: If your mouse has a Scroll Wheel you can use this tool by 
clicking in the map windows, then scrolling forward to zoom-in or 
backwards to zoom out. 

Zooming out from the Map 
 

Select “Zoom Out” from the Move tool menu. 
 

The shape of the pointer changes to indicate that the 
Zoom Out tool is active.  While the Zoom Out pointer is 
active you can: 

 
• Reduce a single point of interest by clicking the 

Zoom Out pointer at that point on the map. This redraws the map at 
half the scale and positions the selected point is at the centre of the 
map window.  

 
• Reduce a region of interest by clicking and dragging the Zoom Out 

pointer across (for example, from the top, left-hand side to the 
bottom, right-hand side of) the area of interest. This redraws the map 
so that the area currently displayed in the map window is as small as 
the selected area. 

 
• Use a combination of these techniques to size the map as required.  

 
• NOTE: If your mouse has a Scroll Wheel you can use this tool by 

clicking in the map windows, then scrolling forward to zoom-in our 
backwards to zoom out. 
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Using the Pan Tool  

 
Select “Pan” from the Move tool menu.  The shape of 
the pointer changes to indicate that the Pan tool is 
active.  

 
• Click and hold the left-hand button of the 

mouse while moving the pointer in any 
direction.  The map slides across the map 
window in the same direction as the pointer. 

• Release the mouse button when the map is positioned as 
required. 

• You can continue to use the Pan tool to reposition the map within 
the map window. Switch to another tool when you’re finished with 
this tool. 

• NOTE: If your mouse has a Scroll Wheel you can use this tool by 
clicking once on the scroll wheel button, then moving the mouse.  
The map will pan to follow the direction of mouse movement. 

Other Options 
 

Back.  Select this to cancel the last map movement command and restore 
the map to the previously displayed view. 
 
Show All Tracks.  This option immediately resizes the map so that all 
selected mobiles can be seen. 
 
Jump To.  Displays a dialog allowing you to specify the map area to view, and 
options to change the map scale.  To change the distance units (e.g. degrees, 
miles) use the [Select]Æ[Map Properties] menu option. 
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Automatic Map Zooming 

 
When a new set of mobile unit(s) is placed on the map, SmartTRAC 
automatically sets the zoom and pan settings to ensure all mobiles within the 
new selection are visible. 
 
When new data is received from mobile units, SmartTRAC redraws the 
display.  However, in this case it does not alter the zoom or pan settings by 
default.  If you would like SmartTRAC to automatically zoom and re-center the 
display when mobile units update; turn the [View]Æ[Auto Follow] option ON. 
 
Auto Follow is particularly suited to display terminals that operate in 
unattended mode such as video projectors or flat panel wall displays.  When 
activated, Auto Follow allows SmartTRAC to continuously adjust the display 
for optimum presentation of the selected mobile units. 
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Viewing Different Levels of Detail  

Displaying a Mobile’s Track 
 

By default only the current location of a vehicle is displayed.  Enabling the 
track display provides additional information based on the historical location 
and path of the vehicle.  To display tracks: 

 
• Open the [Analyze] menu, and click 

on [Tracks]. 

• The map is redrawn to include the 
route traveled by each mobile. 

• To turn tracks off, select the 
[Analyze] Æ [Tracks] menu option 
again. 

As tracks often overlap and double-back small arrows along the track are 
used to indicate direction.  The mobile unit symbol at the end of the track 
(current location) is also orientated to show the direction of the mobile based 
on the last two position reports received. 

Displaying the Location of each Position Report 
 

Track data provides an overview of the history of a vehicle.  For further detail 
on each position report received (the dots that the track is connecting) it is 
necessary to display position reports.  To do this: 
 

• Open the [Analyze] menu, 
and click on [Position 
Reports]. 

• The map is redrawn to 
include the location of the 
displayed mobiles at each 
position report. 

 

Displaying a Unit’s Opportunity Ellipse 
 

Opportunity ellipses identify the distance a unit could have strayed from its 
track according to its current speed. You can view the opportunity ellipses for 
a selection of mobiles as follows: 

 
• If the mobile isn’t already 

displayed on the map, add it 
to the map now. 

• Open the [Analyze] menu 
and click the [Ellipses 
(Routine)] option to view 
ellipses for all displayed 
units. 
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Viewing Sightings 

 
Mobile Units typically report their position automatically.  For surveillance 
orientated systems a facility is also provided to enter sightings, or manual 
positions, that can then be compared with the automatically received locations 
from mobile units.  To display sightings: 
 

• Open the [Analyze] menu, 
then click [Sightings]. 

• The map is redrawn to show 
the location of any sightings 
of the displayed mobile; a dot 
and description mark each 
sighting.  

• Sightings are generally 
viewed in conjunction with the automatically reported track.  The 
example illustrated shows two Sightings for "Trial A".  One is 
consistent with the trace from automatic reporting, the other appears 
to be in error, or has been reported against an incorrect mobile 
designation.  A surveillance operator would then use this information 
to investigate further why this discrepancy could have occurred. 

• Systems configured to support sightings information also have a 
special mobile unit added.  This is named "Unresolved Sightings" 
which is used to display sightings that are not presently assigned to 
any mobile unit within the fleet.  Such sightings typically represent 
partial surveillance information; i.e. a vessel was spotted by a 
surveillance aircraft but could not be identified properly by 
international radio callsign.   
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Selecting Mobiles from the Map 
 

The Map Selection works in conjunction with the Unit Filter, Unit List and 
Status bar.  

Selecting a Single Mobile 
 

• Select the [Pointer] item from the [Select] 
tool menu. 

• The shape of the mouse pointer changes 
to indicate the selection tool is active. 

• Click on any mobile unit on the map.  

• The selected mobile is highlighted on the 
map and the corresponding mobile in the 
unit list is also marked with a gray rectangle. Any previously selected 
mobiles are automatically deselected. 

Selecting All Mobiles within a Rectangle/Circle 
 

• Select the [Rectangle] or [Circle] item from 
the [Select] tools menu. 

• The shape of the mouse pointer changes 
to indicate that the selection tool is active.  

• Position the mouse pointer at one corner of 
the area of interest on the map. 

• Click and drag across the area of interest on the map (for example 
from top-left to bottom-right). 

• A rectangle or circle is drawn over the map; the boundary of which is 
controlled by the current position of the pointer with respect to the 
point you commenced dragging. 

• Drag the pointer until the rectangle encloses all units of interest, then 
release the mouse button. 

 
All mobiles within the boundary are selected and highlighted on the map.  
Also, the corresponding mobiles in the unit list are marked with a gray 
rectangle. Any previously selected mobiles are automatically deselected. 
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Selecting all Mobiles within a Particular Geographic Area 
 

• Select the [Region] item from the [Select] 
tools menu. 

• The shape of the pointer changes to 
indicate that the selection tool is active. 

• Click the pointer anywhere within the 
zone of interest. 

 
All mobiles within the zone are selected and highlighted on the map. Also, the 
corresponding mobiles in the unit list are marked with a gray rectangle. Any 
previously selected mobiles are automatically deselected. 
 

• You can use any region style object from the map as a boundary 
area for this function. 

• The [Draw] tools can be used to create custom regions for use 
with this tool. Drawing tools and their use are discussed in detail 
later in the section Drawing and Annotating the Map. 

Map Selection and the Unit List 
When selecting units on the Map, the same units are also highlighted in the 
Unit List.  This allows cross comparison between geographic details (location) 
and the unit details such as name and mobile unit type. 

This combination of Map and Unit List selection can also be used to more 
easily locate, view and edit mobile details.  For example: 

• Select mobile unit(s) on the 
map using individual, circle 
or rectangle tools. 

• The same units are also 
highlighted in the Unit List 
(as gray rectangles) 

• Right click on one of the 
selected units in the Unit 
List.  The highlight color 
changes to blue, and a 
menu appears 

• Select [Properties] 

 

The Properties dialog opens: 

• If multiple units are selected then the 
attributes that are common for all 
selected mobiles are displayed.  Other 
attributes are left blank. 

• If only one mobile is selected then full 
details for that mobile unit are 
displayed. 

• Using the Properties dialog it is 
possible to edit the attributes of the 
mobile such as its name, symbol color or reporting rate.  Further 
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information on these functions is given in the section Editing Mobile 
Details. 

• When you finish viewing mobile details you can close the [Properties] 
dialog to save space -- or leave it open to show the attributes of the 
selected mobiles automatically as the selection changes. 

Attributes of a Mobile 
 

A mobile displayed in the Unit List or in the Properties dialog has several 
categories of attribute.   

Some are standard on all SmartTRAC systems - such as a mobile callsign, 
name and type.   

Other attributes may be enabled or disabled by a systems administrator 
depending on the application SmartTRAC is configured for. 

Although the exact set of attributes can vary, the most commonly configured 
attributes are: 

Attribute Description 
Callsign A short identifier for the mobile.  Typically a Car Number, Vessel Radio 

Callsign or similar.  The callsign should be a compact, but unique, 
identifier for the mobile unit. 

Name The full name of the mobile unit.  This attribute is optional and does not 
need to be unique. 

Type The type of unit.  The use of this attribute is at the discretion of the 
system administrator.  Typically it is based on either the type of mobile 
asset (car, truck etc) or the usage of the asset. 

Country The country of origin/ownership of the mobile unit. 
Flag For maritime systems only; the flag of registration for a vessel 
Length For maritime systems only; the length of the vessel in meters 
Weight The weight of the unit in tons/tonnes 
Max Speed The maximum speed the unit can travel.  Expressed in the distance 

units of the map.  For example; miles/hour if the system map being 
used designates miles, km/hour if the map designates kilometers and 
knots if the map is measured in nautical miles. 

Last Alert The generated event "Alert" in relation to this unit.  Alerts are significant 
events, as configured by a manager or systems administrator. 

Last Alert Date The date and time that the "Last Alert" was generated, in local time. 
Update Rate The automatic reporting rate for the unit in minutes.  Units that report 

more often than once per minute have a decimal figure; for example 0.5 
minutes = 30 second reporting. 

E-Mail The e-mail address of the mobile, if supported.  Mobile units with an e-
mail address can have messages sent to them in conjunction with your 
e-mail application. 

Channel The type of wireless network the mobile unit uses.  If this field is not 
displayed only one network has been configured for use on this system. 

Input #1,2,3 … Digital or analog input sensors (temperature, door open/close etc.).  
Generally the systems administrator renames these as appropriate.   

Output #1,2,3… Digital outputs.  For example an engine immobilize.  The systems 
administrator will configure these as appropriate. 
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Status of Selected Mobiles 

 
The Status Bar shows information on the current selection within the Map 
Window.  The fields available (left to right are): 

 
1. Context Help: Shows a short description of the current menu function.  

To activate this; open a menu and move the pointer over it.  When no 
menu activity is occurring, this field shows "Ready". 

 
2. Range:  Active only when targets are designated on the map. To 

designate targets: 
 

• Use any [Select] tool to click on any mobile unit on the map.  This 
designates the first target, known as the "A" target.   

• To define a second target (or "B" target), hold down the [Shift] key 
and click on another mobile unit. 

• If only an "A" target is specified, the current cursor location takes the 
place of the "B" target.  In this way you can select one target, then 
move the mouse over points of interest.  The display will then update 
the range from the selected target to the current point. 

• The units used are based on the map settings.  For example; you 
would see "mi" (for miles) if the map is configured to measure 
distances in miles.  "km" (kilometers) and "nmi" (nautical miles) are 
also common settings for distance measurement. 

 
3. Bearing: Active only when targets are designated on the map. 
 

• The bearing from the "A" target to "B" target in degrees (or) 

• If there is no "B" target defined, this field shows the bearing from the 
"A" target to the current cursor location. 

 
4. Speed: Active only when targets are designated on the map. 
 

• The current speed of target "A".   

• This is calculated from the last two position reports received from this 
mobile. 

 
5. Estimated time of Arrival (ETA): Active only when targets are 

designated on the map. 
 
• The time taken to traverse from target "A" to "B" (or from target "A" to 

the current cursor location if no "B" target selected). 

• The ETA is shown in days, hours, minutes and seconds. 

• This function assumes the shortest possible path (known as a great 
circle route) is taken.   

• The speed of the unit is assumed to remain constant. 

 
6. Latitude:  The Latitude of the current cursor location.  Normally this is 

expressed in the format Degrees, Minutes, Decimal Minutes (although a 
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systems administrator can reconfigure this to alternate formats).  The 
latitude is expressed in the datum currently selected for map display.   

 
7. Longitude:  The Longitude of the current cursor location. Normally this is 

expressed in the format Degrees, Minutes, Decimal Minutes (although a 
systems administrator can reconfigure this to alternate formats).  The 
longitude is expressed in the datum currently selected for map display. 

 

Deselecting Mobiles 
 

Selected mobiles are automatically deselected whenever you make a new 
selection.  
 

• If you want to add some mobiles to the current selection press the 
[Shift] key while using the Select tools in the usual way. 

• If you want to deselect all mobiles, use the [Select] Æ [Unselect 
All] menu option. 
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Monitoring Mobile Movement 
 

The Analyze menu contains the tools used to display information related to a mobile’s 
activity.   Before using these tools you should first display the relevant information 
from a selection of mobile(s) on the map. 

Information Tool 
 
The information tool is useful when there is too 
much data to display effectively.  To use the Info 
tool: 
 

• Select the [Info] tool from the Analyze 
tool palette. 

• Click on an object of interest (e.g. a 
mobile unit or map location) 

 
The info dialog box appears.   
 

• If only one layer is selectable then this dialog will show the details 
of the object under the cursor location. 

• If multiple layers have selectable objects, a summary is 
presented.  Select a line in the summary list to show full details of 
the item in the selected layer: 
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Measuring Distance  

 
You can measure the distance between locations on the map as follows: 

 
• Select [Ruler] from the [Analyze] 

tool menu. 
 

The Ruler dialog appears and the shape of the pointer changes to show that 
the Ruler tool is active. The Ruler dialog overlays part of the map and can be 
moved if it is hiding information of interest. Initially the values shown in the 
dialog are zero. 

 
• Click on the first point of interest on the map.  A square marker 

identifies the selected location.  

• Move the pointer to the second point of interest. 

 
The Distance shown in the Ruler dialog is updated as you move the pointer 
across the map.  You can now continue to move the pointer around the map 
display, noting the distance between the fixed point and locations of interest 
on the map.  

 
When you want to make measurements from a different point, double-click 
anywhere on the map, or press the Esc key.  When you’ve finished 
measurements switch to a different tool and close the Ruler dialog. 
 
If you want to reposition the map between measurements select the 
appropriate Move tool and move the in the usual way. The Ruler dialog 
remains active and you can resume measurements at any time by selecting 
the Ruler tool. 
 
NOTE:  When measuring distances you can press the “S” key, to snap to the 
nearest point (symbol, line etc). To disable snap, press the "S" key again. 
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Label Tool 
 

You can add pre-defined labels to objects such as 
mobiles, tracks and reporting points on the map. 
 

• Select “Label” from the [Analyze] tools menu.  The shape of the 
pointer changes to indicate that the Label tool is active. 

• Click the pointer on the object to be labeled.  A text label appears 
beside the selected object on the map.  

• Repeat until all objects of interest have been labeled. 

• When you’ve finished labeling switch to a different tool. 

 
Note:  Advanced users can experiment with the custom labeling options in the 
Layer Settings dialog, available via the Select tools menu. 

 
The text shown on the label is based on the map layer that is topmost at the 
location being clicked. 
 
Some map layers are set to automatically label items at a certain zoom level 
(magnification).  However, to reduce screen clutter most elements of the map 
backdrop will label only when you specifically use the 
Label Tool.   
 
Once a label is placed you can drag it to a more 
convenient location on the map.  An arrow will extend 
back to the original location.   
 
A label can also have its content, size text style and 
alignment altered.  To alter a label double click on the 
item, which displays the options in the Label Style 
dialog. 
 
 

 

Clear Labels  
 
When you want remove all labels from the map: 

 
• Click on the [Analyze] tools menu and choose the [Clear Labels] 

option.  

• Confirm that you want to remove all custom labels when prompted to 
do so. 
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Displaying Historical Data 

Date Bar 
 

During routine fleet monitoring the Track Explorer displays and updates tracks 
on screen each time a position report arrives; i.e. an on-screen track 
represents a unit’s activity from a particular point in time until now.  
 
SmartTRAC also automatically records all data received from each mobile so 
that activity can be reviewed at a later date. The Date Range slider allows you 
to specify the date/time interval of interest when viewing positions, tracks or 
other information from a mobile unit. 
 
The date bar works as follows: 
 

• The blue area of the bar depicts the track 
duration.  This area cannot be altered 
directly but moves automatically such that the slider is always 
with in the "track window" denoted by the blue area.  

• The slider indicates where on the track the current 
location icons are displayed.  Click and drag to alter the 
selected date as follows:   

• If the slider is located at the right edge of the track then the 
icons display the most recent position received within the 
selected date and time range.   

• Conversely, if the slider is at the left edge of the track the 
icons are displayed for the first position in the selected date & 
time range. 

• Placing the slider in any other position 
along the track causes the map to redraw 
with the icons showing the approximate 
geographic location of each mobile at the selected date and 
time.   The selected date and time is updated as you move 
and shown directly below the slider control. 

• NOTE: The position approximation is made based on the 
nearest two positions received (by date and time) against the 
requested date.  The algorithm used assumes that the mobile 
traveled in a straight line between the points.  If the mobile 
unit reports infrequently, or position reports are widely 
spaces, this algorithm can produce results that are non-
optimal.  For example; placing a mobile between streets in a 
city or displaying a maritime asset on land (i.e. where the 
track goes from one side of an island to another).  These 
limitations are caused by the resolution of the source data. 

 
Within SmartTRAC all dates and times are stored in the database in UTC 
(Universal Coordinated time) also known as GMT or Greenwich Mean Time.  
Before display the dates and times are converted to local time.  This means 
that two users accessing the same database, but located in different countries 
or timezones, will see different date & times labels although the source data is 
identical.
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To see which timezone your computer is configured for, 
double click on the clock on the Windows Taskbar.  If you 
have default Windows settings this is located at the bottom 
right corner of your computer monitor.  
 
This displays the following dialog.  Select the 
"Time Zone" section to specify how 
SmartTRAC should translate dates and times 
from UTC to local time.  

 
 
 
 

Changing the Time/Date Interval of Interest 
 

You can change the active time interval directly as follows: 
 

• Right-click on the Date 
Range slider and select the 
[Date Range] menu option.  

• Set the track length 
(for example 2 
weeks) and the 
approximate date of 
interest (for 
example 1 
September 2000) 

• The "Datebar" 
section permits the scale of the datebar to be specified.  By 
default this is automatic.  You can also specify an explicit scale; 
i.e. 1 Week, 3 Months as appropriate for the type of analysis being 
performed. 

• The "Alignment" specifies where the icons are drawn relative to 
the track: 

This option starts the date range from the selected 
date.  For example; selecting 1 Week from 
1/Jan/2001 would result in a track that from 1 Jan to 
7 Jan 2001 with the icons placed at 1 Jan 2001.  This 
method of display is suitable for display of historical 
tracks only. 

This option centers the track on the selected date.  
Use this option where you want to see track 
immediately prior to and following a specific event. 
This method of display is suitable for display of 
historical tracks only. 

This option displays track history prior to the selected 
date.  Use this option when monitoring activity in real 
time. 
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Viewing which Mobiles were Active at a Particular Time 

 
• Click on the date range slider and drag it left (to go backwards 

from the current date) or right (forwards from the current date). 
When the date and time of interest are displayed below the slide 
bar release the slider. 

• Alternatively, you can use the Date Range dialog (above) to go 
directly to a specific date range and duration. 

• The displayed mobiles are repositioned according to the retrieved 
data, or removed from the map if they weren’t active during the 
selected time period. 
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SmartTRAC Information Layers 
 

When information is displayed on the map it is typically shown in graphical form 
against the map backdrop.  Some attributes of the data are implicit to presentation in 
this manner - for example latitude & longitude.  Using tools such as the Info tool and 
Labeler (see preceding sections) further information is available. 
 
This section describes what information is available for each layer.  This 
is  most applicable when objects are selected with the Info tool, or data 
is exported to other applications such as Microsoft® Excel.  

Current Location 
 

Activate this layer by selecting [Analyze]Æ[Current Location].  This following 
information is then available with the [Info] tool in relation to each symbol 
displayed.  

 
Attribute Description 
ShortName The short identifier; identical to the callsign 
LongName The full name of the mobile unit 
Date & Time The date and time that the position was obtained.   

NOTE: This may differ from the current time as the unit could be 
blocked from transmitting, be unable to establish its location through 
GPS, or may not be configured to report automatically.  

Latitude The latitude of the mobile unit.  The format is normally Degrees, 
Minutes, Decimal Minutes (although this can be reconfigured by the 
systems administrator to alternative representations).  The datum is 
WGS84. 

Longitude The latitude of the mobile unit.  The format is normally Degrees, 
Minutes, Decimal Minutes (although this can be reconfigured by the 
systems administrator to alternative representations).  The datum is 
WGS84. 

Altitude Altitude in meters above mean-sea-level.  This value is 0 if the altitude 
is unknown or not supported by the mobile unit. 

Distance The distance between the previous position and this one.  The distance 
is measured on the most direct route from the previous position, known 
as a great circle route.  The units of measurement are as specified 
according to the settings for the map.  Common units of messages are 
miles/hour, km/hour or nautical miles. 

Speed & 
SpeedUnits 

The speed, expressed in SpeedUnits (i.e. miles/hour, km/hour, knots) at 
which the unit is estimated to have traveled.  The speed is calculated as 
an average from the last two positions, assuming a straight line 
(shortest distance) between the last two positions on the track. 

Reported Speed The speed, expressed in SpeedUnits that the unit reported it was 
travelling at the time of the position report.  This may be significantly 
different from the average speed and is also commonly called the 
instantaneous speed.    Many tracking units do not report this value, in 
which case the display is -1. 

Course The course-over-ground in degrees.  For land based systems this is the 
same as the heading or bearing of the unit.  In maritime or aeronautical 
systems this is the true course (over ground).  Due to the influence of 
tide and wind the bearing of the vessel or aircraft can differ significantly 
from its course. The course is calculated as an average from the last 
two positions, assuming a straight line (shortest distance) between the 
last two positions on the track. 

Reported Course The course-over-ground in degrees as reported by the unit at the time of 
position report.   This is also known as the Instantaneous Course. Many 
tracking units do not report this value, in which case the display is -1. 

Pos Type The type of position. Not all mobile types support all codes.  Generally 
these codes are not used directly, instead they are accessed by the 
Alerting system and are combined into easily understood groupings in 
the "Unit Status" folder related to mobile units. 
 
Advanced users can find a full list of the supported codes for a 
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Attribute Description 

particular system in the VMS_ALC_POSITION_TYPE table within the 
database. 
 
Commonly included values are: 
 

• 0: Normal (GPS) position 
• 11: Normal (GPS) position  
• 64: The mobile unit has powered on 
• 65: The mobile unit is powering off  
• 66: A Power Failure (unplanned shutdown) occurred 
• 80: The mobile unit is entering a low power (sleep) mode 
• 81: Normal (GPS) position, from a unit in sleep mode 
• 82: The mobile is exiting a low power (sleep) mode 
• 83: A low power unit has activated to accept commands 
• 257: Unit has changed to internal/battery power source 
• 258: Unit has moved to external power source 
• 259: Battery Low 
• 260: Assistance Required / Panic Button 
• 300-304: Doppler/Direction finder position reports 
• 256: Manual Position Reports 
• Codes above 1024 are internal representations of digital 

or analog sensors (temperature etc.).  Full details of how 
these input types are coded can be found in the Systems 
Administrator and Developer Documentation for 
SmartTRAC. 

Quality The quality of fix.  0 is the lowest (most unreliable) value through to 9 
which represents the best quality fix possible (most reliable).  The exact 
interpretation of this field depends on the type(s) of mobile units and 
wireless networks used with the system.  Further information is 
contained in the Systems Administrator documentation. 

EntityId This value is generated by SmartTRAC for internal purposes 

 

Activity  
Often, when many mobile units are displayed the track display can 
become cluttered.  In this case it is difficult to determine the sequence 
of events - that is, the order in which activity occurred.  The Activity 
layer provides an alternative view of the same information that is 
normally displayed in a static manner. 
 
Using the Activity layer, after selecting an appropriate date provides 
an animated replay of the sequence of movements from the selected 
date/time to the end of the active time interval.  This real-time 
animation of activity can be a valuable tool in better understanding 
fleet movements and activity across time. 
 
The Activity Layer is activated through 
the [Analyze]Æ[Activity] menu item.   
 

• Activating the [Activity] 
Animation deactivates the 
[Current Location] layer.  

• Conversely, activating the 
[Current Location] layer will 
deactivate (stop) any 
Activity Animation. 

 
The Activity Animation uses the same data as the Current Location 
layer, specifically an icon representing the location of a mobile unit at 
a given point in time.  However, unlike other layers, the Activity layer 
creates an animation of the current map view by automatically 
stepping through the selected date range.  For this reason you cannot 
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use some tools such as the Info tool and Labeler in conjunction with 
an Activity Animation. 
 
To start an Activity Animation: 

 
• Select the date/time interval of interest using the Date 

Range tools.  

• Select [Activity] from the [Analyze] tools menu. 

 
Movement of the selected mobiles is replayed on screen. You can 
continue to use most tools and functions during animation.   

 
• To replay a portion of the animation, move the Date Bar 

Slider back or forward.  The animation will fast forward or 
rewind as the current location is altered.  The current date    

 
• To stop the animation, select the [Current Location] layer 

in the Analyse tools menu.  
 

For performance reasons there are some limitations on which tools 
are available, and some functions may operate more slowly, while an 
Animation is running. 

Position Reports  
 

Activate this layer by selecting [Analyze]Æ[Position Reports].   
 
Information available for each point in a position track is identical to that 
shown for a mobile under [Current Location].  Please refer to the [Current 
Location] description for details on each attribute. 

Tracks  
 

Activate this layer by selecting [Analyze]Æ[Tracks].  This following information 
is then available with the [Info] tool in relation to each track line for a mobile. 

 
Attribute Description 
ShortName The short identifier; identical to the callsign 
LongName The full name of the mobile unit 
TrackStartDate & 
TrackStartTime 

The start date & time for the track.   
This matches the currently selected interval on the Date Bar and is the 
same for all tracks displayed on the map.  

TrackEndDate & 
TrackEndTime 

The end date & time for the track.   
This matches the currently selected interval on the Date Bar and is the 
same for all tracks displayed on the map. 

FirstPosDate & 
FirstPosTime 

The first position received within the selected track interval for this 
mobile.  Each mobile unit on the map has its own first pos date & time. 

FirstPosLatitude The latitude of the mobile unit for the first position in the track.  The 
format is normally Degrees, Minutes, Decimal Minutes (although this 
can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

FirstPosLongitude The latitude of the mobile unit for the first position in the track.  The 
format is normally Degrees, Minutes, Decimal Minutes (although this 
can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

LastPosLatitude The latitude of the mobile unit for the last position in the track.  The 
format is normally Degrees, Minutes, Decimal Minutes (although this 
can be reconfigured by the systems administrator to alternative 
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Attribute Description 

representations).  The datum is WGS84. 
LastPosLongitude The latitude of the mobile unit the last position in the track.  The format 

is normally Degrees, Minutes, Decimal Minutes (although this can be 
reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

Entity Id This value is generated by SmartTRAC for internal purposes. 

 

Sightings  
 

Activate this layer by selecting [Analyze]Æ[Sightings].  This following 
information is then available with the [Info] tool in relation to each sighting 
report.  NOTE: Sightings are only available on Surveillance Edition systems. 

 
Attribute Description 
ShortName The short identifier; identical to the callsign 
LongName The full name of the mobile unit 
Type Primary categorization of sighted entity type  
Flag Country of flag (maritime only) as two digit code 
Date & Time Date & Time the sighting was recorded, in local time 
Latitude The latitude of the mobile unit.  The format is normally Degrees, 

Minutes, Decimal Minutes (although this can be reconfigured by the 
systems administrator to alternative representations).  The datum is 
WGS84. 

Longitude The latitude of the mobile unit.  The format is normally Degrees, 
Minutes, Decimal Minutes (although this can be reconfigured by the 
systems administrator to alternative representations).  The datum is 
WGS84. 

  
Speed & 
SpeedUnits 

The speed, expressed in SpeedUnits (i.e. miles/hour, km/hour, knots) at 
which the unit is estimated to be proceeding.  If the speed of the sighted 
mobile unit is unknown the Speed will be set to -1. 

Course The course-over-ground in degrees that the unit was proceeding at 
when sighted.  If unknown the Course is set to -1. 

Activity Activity at time of sighting.  These codes are defined by a systems 
administrator and are specific to the surveillance application the 
SmartTRAC system is configured for. 

PhotoNum The frame number (film camera) or file number (digital camera) that 
records the sighting.  Set to 0 if no photographic record exists.  Frame 
numbers should be unique with respect to a specific ObserverTrip. 

Confidence The confidence in the validity of the sighting: 
 

1. Confirmed by other sources 
2. Probably true 
3. Possibly true 
4. Doubtfully true 
5. Improbable report 
6. Truth cannot be judged 

ObserverCraft Name or identifier for the observation craft; i.e. aircraft number, vessel 
callsign, unique identifier for satellite acquisition vehicle 

ObserverSource Name of the human source (if known), or automatic observation 
identifier 

ObserverTrip Unique trip identifier.  The combination of ObserverCraft and 
ObserverTrip uniquely identifies this surveillance mission. 

ObserverLatitude As per Latitude, but for the observer craft 
ObserverLongitude As per Longitude, but for the observer craft 
Distance Distance from the observation point to the observed vessel 
Accuracy Estimated accuracy in meters of the Latitude & Longitude.  This figure 

should include both the margin of error in establishing the location of the 
observer and the margin of error in then establishing the location of the 
target (i.e. if the target location is established by range and bearing from 
a radar source).  

EntityId This value is generated by SmartTRAC for internal purposes. 
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Ellipses (Routine & Overdue)  

 
Activate this layer by selecting [Analyze]Æ[Ellipses (Routine)] or 
[Analyze]Æ[Ellipses (Overdue Reports)].   This following information is then 
available with the [Info] tool in relation to each ellipse.   

 
Attribute Description 
ShortName The short identifier; identical to the callsign 
LongName The full name of the mobile unit 
StartDate & 
StartTime 

The start date & time for the ellipse.  This is based on the first (from) 
position that the ellipse is measuring. 

StartLatitude The latitude of the mobile unit for the first position in the ellipse (from).  
The format is normally Degrees, Minutes, Decimal Minutes (although 
this can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

StartLongitude The latitude of the mobile unit for the first position in the ellipse (from).  
The format is normally Degrees, Minutes, Decimal Minutes (although 
this can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

EndDate & 
EndTime 

The end date & time for the ellipse.  This is based on the second (to) 
position that the ellipse is measuring. 

EndLatitude The latitude of the mobile unit for the second position in the ellipse (to).  
The format is normally Degrees, Minutes, Decimal Minutes (although 
this can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

EndLongitude The latitude of the mobile unit for the second position in the ellipse (to).  
The format is normally Degrees, Minutes, Decimal Minutes (although 
this can be reconfigured by the systems administrator to alternative 
representations).  The datum is WGS84. 

Distance The shortest distance between the two points the elipse is based 
around.   

Speed & 
SpeedUnits 

The speed expressed in SpeedUnits (i.e. miles/hour, km/hour, knots) at 
which the unit is estimated to have traveled between the two points in 
the ellipse.  The speed is calculated as an average from the last two 
positions, assuming a straight line (shortest distance) between the last 
two positions on the track.   
 
The difference between the speed calculated in this manner and the  

Course The course-over-ground in degrees.  For land based systems this is the 
same as the heading or bearing of the unit.  In maritime or aeronautical 
systems this is the true course (over ground).  Due to the influence of 
tide and wind the bearing of the vessel or aircraft can differ significantly 
from its course. The course is calculated as an average from the last 
two positions, assuming a straight line (shortest distance) between the 
last two positions on the track. 

Entity Id This value is generated by SmartTRAC for internal purposes. 
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Presentation Styles 
 

By default the tracks, icons, line 
type and line thickness are 
determined when a mobile unit is 
added to the system.  
 
Presentation styles are alternative 
ways to style data for presentation 
on the map.   
 
A systems administrator can 
define Presentation Styles, or alter 
existing styles.  To see what styles 
are defined for your system open 
the [Analyze]Æ[Presentation Style] menu. 
 
By default the following styles are present.  However you should confirm with 
your systems administrator that the settings used on your system are 
consistent with the defaults shown here before relying on the following 
definitions. 

Normal 
 

All position and track data displayed on the map uses the styles set 
for the mobile unit.  This is the default style.  

Color by Position Type 
 

Track and position data is colored according to the status of the 
mobile unit when the position report was recorded.  The default color 
scheme is as follows: 
 

• Blue: Indicates a normal position report 

• Green: Indicates the mobile is in low-power (sleep) 
mode.  Such units cannot be contacted by SmartTRAC 
but will still report their position automatically at a pre-
programmed rate. 

• Red: Indicates a power on/off or fail event.  This typically 
indicates that the mobile has been deactivated 
deliberately. 

• Pink:  Indicates a unit failure (i.e. antenna blocked, 
antenna is disconnected, unit tampered with or battery 
low).  This color indicates that the unit may require 
servicing. 
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Color by Speed 

 
Track and position data is colored by speed.  The default color 
scheme is as follows: 
 

• Red: Indicates the mobile unit is stationary or moving at a 
very slow speed.  By default the threshold is 
approximately 5 km/h, 3 miles/h or 2.5 knots. 

• Orange: Indicates the mobile unit is moving at a slow 
speed.  By default the threshold is approximately 15 
km/h, 10 miles/h or 8 knots. 

• Gray: Indicates the mobile unit is moving at a normal 
speed.  By default this is over 15 km/h, 10 miles/h or 8 
knots. 

Defining Additional Presentation Styles 
 

Systems administrators and advanced users should consult the 
SmartTRAC Server documentation and technical notes for 
information on Presentation Styles.   
 
This provides information on adding new styles to a system or 
changing the default ranges/styles described in this section. 
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Exporting Data 
 

Most data in SmartTRAC can be exported to other applications.  A variety of methods 
and formats for exporting data are available.  These include: 
 

• Printing the map window 

• E-mailing the map window 

• Saving a map window as a picture (bitmap) 

• Copying and Pasting data to other applications 

Printing the Map 
 

If a printer is connected to this PC you can 
print the current view of the map, including all 
mobiles, tracks, labels and annotations:  
 

• Click [Print] in the toolbar (or) 

• Select the [File] menu and choose the 
[Print] menu. 

• Set the print options for your printer in 
the usual way, then click OK. 

• NOTE:  For advanced options, use the 
[File]Æ[Print Setup…] option before 
selecting the [Print] menu. 

 
 
 
 
 
 

E-Mailing the Map 
 

If a supported e-mail application is installed 
you can e-mail a copy of the map directly. 
 

• Select the [File] menu and choose 
the [Send Map…] option.  

• The map is embedded into a new e-
mail message. 

• Address the e-mail, add any 
comments or other attachments to 
the message, then click [Send]. 
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Saving the Map Window as a Picture 
 

The map window can be exported in a variety of graphics formats, for 
inclusion in other documents, web pages etc.  To export the map as a picture: 
 

• Select the [File] menu and choose 
the [Export Picture…] option.  

• The "Save Window As" dialog 
appears.  The size of the exported 
image can be specified (by default 
the current window size is 
selected). 

• Further control of how certain 
types of map objects are exported 
is available with the [Advanced] 
option. 

• Click [Save…] to select the format 
and filename for the image.  

• NOTE: Depending on the type of 
image file, and the size of the 
image saved this function may create large files.  It is recommended 
that the JPG format or Windows Enhanced Metafile be specified, as 
these are the most compact picture formats. 

 

Exporting Mobile Unit Details  
 

To copy the attributes of the mobile (callsign, name, type etc.) 

• Select mobile(s) either on the Map or in the 
Unit List.  Any selection tool described in the 
preceding chapters can be used to 
accomplish this task. 

• Right-click on the mobiles in the Unit List 
and select [Copy]  

• Open another application, for example 
Microsoft® Excel 

• Select [Edit]Æ[Paste] 

NOTE:  As an alternative, and faster, method you can drag-and-drop 
mobiles directly from the Unit List into another application. 
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Exporting Track Details  
 

Current locations, position reports or tracks can be copied in either text or 
graphical format by selecting [Edit]Æ[Copy].  The resulting information can 
then be pasted into programs such as Microsoft Word or Excel for further 
analysis.   

The exact sequence of steps differs depending on the type of data (text or 
picture) that is desirable: 

To copy a selection from the map as a graphic image: 

• Use the [Analyze] options to enable only the layer that you wish to 
copy.  For example; [Position Reports]. 

• Select the mobiles on the map 
and then choose the [Edit] 
Æ[Copy] menu item.   

• Open another application, for 
example Microsoft® Excel, and 
select [Edit]Æ[Paste Special…] 

• Select the [Picture (Enhanced 
Metafile)] option.   

To copy a selection from the map in textual form: 

• Use the [Analyze] options to enable only the layers that you wish to 
copy.  For example; [Position Reports].  

• Select the mobiles and then 
choose the [Edit] Æ[Copy] 
menu item.   

• Open another application, for 
example Microsoft® Excel, and 
select [Edit]Æ[Paste Special…] 

• Select the [Unformatted Text] 
option.   

• A tabular view of the selected data is inserted.  The information is 
dependent on the type of data; i.e. positions, tracks, current location 
of the mobile unit.  For a full description of the fields applicable in 
each case please refer to the section SmartTRAC Information Layers.  
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Exporting the Entire Map  
 

It is possible to export an entire map image.  This differs from exporting only a 
portion of the data.  When the entire map is exported the receiving 
application, such as Microsoft® Word or Excel can access all details on the 
map and tools such as zoom and pan can be used directly in the receiving 
application. 

To export the map:  

• Click anywhere within the map window. 

• Choose the [Select]Æ[Unselect All] menu item (if this item is grayed 
out the there are no items to unselected and you can go to the next 
step). 

• Select the [Edit] Æ[Copy] menu item.  

• Open another application, 
for example Microsoft® 
Excel. 

• Select [Edit]Æ[Paste] 

• The map window is inserted 
into the application.   

• Double-click to activate the 
map image.  A toolbar 
appears with a basic set of map navigation tools.  You can then 
resize the map and change the view or layer settings. 

• NOTE:  A map inserted into another application is only active on the 
machine that created the image and other machines with an identical 
SmartTRAC configuration.  If you subsequently send a document 
containing an embedded map to other people they can view the 
image, but not resize it or change the map layer options. 
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Sending Commands to Mobile Units 
 

Mobile tracking units report their position automatically to SmartTRAC.  The 
configuration of the mobile unit can also be altered remotely for example to make the  
unit report its position more frequently. 

NOTE: The exception is when using a wireless or satellite network that is one-way 
only.  If a mobile unit can send data to SmartTRAC, but not visa versa, then the 
command functions described here are not supported. 

Depending on the sophistication of the tracking device(s) used additional functions 
may also be available.  These include two-way messaging (e-mail), logging of position 
data while out the mobile is outside wireless coverage areas and control of external 
devices (engine immobilizes, door lock/unlock etc). 

SmartTRAC supports most functionality offered by tracking devices available in the 
market today.  However, there are differences in regard to the functions supported for 
any given vendor’s tracking equipment.   Also, not all vendors support the functions 
provided by SmartTRAC so some requests to a mobile unit may fail. 

As far as possible SmartTRAC makes the details of how a tracking device operates 
transparent to an operator.  Basic tracking operations work similarly on different 
vendor’s equipment.  Translation is performed automatically to perform a function as 
close as possible to that requested; for example where a tracking device cannot 
report its position automatically SmartTRAC will request an updated position on a 
regular basis to simulate the same feature. 

NOTE:  Absolute publishes technical notes for systems administrators and advanced 
users that describe in detail how support is implemented for each wireless network 
and vendor platform.  Please refer to the Tech Center on 
www.AbsoluteCommunications.com for further information. 

Requesting an Immediate Position Update 
 

Mobile units typically report according to pre-configured criteria.  In addition, 
you can also request an immediate position update at any time.  To do this: 

 
• Use any combination of the map selection tools, for example; 

[Map]Æ[Pointer] to select 
mobile units on the Map (or) 

• Highlight mobile units 
directly in the Unit List. 

• Once you have selected the 
mobile unit(s), right-click on 
the highlighted item(s) in 
the Unit List.  

• Choose the [Update 
Position Now] item. 

• A request is queued for transmission to each mobile.  The position 
of the selected mobile(s) will be updated on the map as new data 
is received.   

 
NOTE: You can continue working while the request is in progress.  Depending 
on the wireless network(s) in use with the system the response to this request 
can vary from 1 second to 15 minutes.  See your systems administrator or the 
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Absolute technical reference material for further information on how quickly 
you should expect a given tracking device to respond. 

Sending an E-Mail Message 
 

If the mobile unit has an e-mail address, or supports text messaging to you 
can send a message to the driver/captain: 

 
• Select mobile unit(s) from the Unit List. 

• Right-click and choose the "Send Message" option.  

• Your e-mail program is 
displayed, with the address 
details already entered. 

• Type a message and click 
[Send] to transmit the 
message. 

• NOTE: If the Send Message 
option is grayed out the 
mobile does not support e-
mail or  you do not have a 
supported e-mail application 
installed on your computer. 

 
A message is transmitted to the mobile unit.   
 
You can send to multiple units simultaneously by selecting a group of mobiles 
from the List, then right-clicking to bring up the menu. 
 
NOTE:  Depending on the wireless network(s) being used with the system the 
delivery of the e-mail to a mobile can take 5 second to 2 hours.  See your 
systems administrator or the Absolute technical reference material for further 
information on how quickly a unit should receive the message. 

Downloading a Logfile 
 

Some mobile units can store a "logfile" of information onboard the vehicle, 
vessel or aircraft.  This information is not sent to the base automatically but is 
stored in case it may be required at a later date.  The size of the log (i.e. how 
many positions can be stored) and the criteria for what information is logged 
differ according to the unit vendor. 
 
To request information from the logfile use the [Retrieve Position Log…] 
command.  This will request any supplementary log information from the 
mobile unit against the currently selected date range.   
 
NOTE: For information on selecting a date range, refer to the Date Bar 
section. 
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To download the logfile from a mobile unit: 

 
• Highlight the appropriate 

mobile(s) in the Unit List and 
right click. 

• Choose the [Retrieve Position 
Log] item. 

 

 

 

• The date range is 
displayed for 
confirmation.   

• If you select "Yes" a 
command is queued 
requesting a log 
download. 

 
NOTE: You can continue working while the download is in progress.   
 
Depending on the wireless network(s) in use with the system the response to 
this request can vary from a few seconds to several hours (for a large log 
download).  See your systems administrator or the Absolute technical 
reference material for further information on whether Log Downloads are 
supported, and what limits apply to the size of the log for a particular type of 
tracking device. 
 

Selecting a Reporting & Logging Rate 
 

Use the reporting rate to determine how often mobile unit reports its position 
to the SmartTRAC system.  The criteria can be based on time; i.e. report 
every 15 minutes, or a combination of time and distance, i.e. report every 15 
minutes or every 5 miles. 
 
A Logging Rate can also be specified.  This relates to the Log Download 
function and determines how often the unit should store positions internally. 
 
NOTE: Only the most advanced types of tracking unit presently support this 
function - and some units log information differently (i.e. based on door 
open/close triggers, the vehicles stopping etc) and may ignore or only partially 
support the settings specified here. 
 
To specify the reporting and logging rate parameters: 
 

• Highlight the appropriate 
mobile(s) in the Unit List and 
right click. 

• Choose the [Properties] item.  

• The Properties dialog is 
displayed. 
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• Select the [ALC] tab 

• Specify the reporting rate to 
the base.  In this example 
every 120 minutes (2 hours) 
or every 30 nautical miles 
has been selected.  

• Optionally; specify a Logfile 
rate and distance.  In this 
example the logfile is 
updated every 15 minutes. 

• Click [Apply] to save the 
settings.   

• The appropriate messages will be queued to reconfigure the 
mobile. 

 
 
NOTES: 
 

• The (default) setting for a reporting rate means to use the system 
default value.  This is configured by the systems administrator and 
is used by all mobile units which do not have an explicit reporting 
rate specified. 

• To report faster than one minute select a decimal number.  For 
example; 30 seconds = 0.5 minutes. 

• Take care when entering longer values.  The figures are in 
Minutes, and entering 4:00, incorrectly intending 4 hours is 
interpreted as four minutes.  The correct setting for this example 
would be to enter 240 (minutes). 

• Some mobile units do not support the distance parameter (i.e. the 
miles, kilometers, nautical miles field).  In this case only the time 
value is used and the distance parameter is ignored. 

 

 

The current reporting rate can be viewed on 
the Filter.  As an alternative to changing the 
reporting rate from the Properties dialog you 
can drag-and-drop mobiles into the 
appropriate folder directly from the Unit List.  
This is equivalent to changing the "Report to 
Base" setting on the [ALC] settings. 
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Setting Digital Output Lines 

 
Some mobile units have "output lines".  These can be connected to a variety 
of external sensors to provide control of activity such as engine immobilizers, 
remote door lock/unlock control, valve control and other similar devices. 
 
The systems administrator determines the number of digital output lines and 
their configuration.  To view the output lines configured for the system (if any): 
 
 

• Highlight a mobile(s) in the Unit 
List and right click. 

• Choose the [Properties] item.  

• The Properties dialog is 
displayed. 

 

 

 

 

 

• Select the [Input/Output] tab 

• To change the status of a 
Digital Ouput line, select from 
the drop down list of options.  

• Click [Apply] to save the 
settings. 

• The appropriate messages 
will be queued to transmit configuration parameters to the mobile. 

 

 

NOTE: 
 

The current status of the digital 
output lines can be viewed on the 
Filter.  As an alternative to 
changing the status from the 
Properties dialog you can drag-
and-drop mobiles into the 
appropriate folder directly from the 
Unit List.  
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Viewing and Editing Mobile Details 

The Properties Dialog 

 
The Properties Dialog displays detailed attribute information on either; 

• A single selected mobile (or) 

•  A group of selected mobiles.   

You open the Properties dialog by right clicking on unit(s) in the Unit List.  
Attributes are categorized according to type with tabbed dividers along the top 
of the Properties dialog. 

NOTE:  Once the properties dialog is open it will automatically update 
whenever the selection on the Map or Unit List changes.  You can therefore 
use the Properties dialog in conjunction with all map selection tools (i.e. 
[Select]Æ[Pointer] and [Select]Æ[Rectangle]). 

Depending on whether a single mobile is selected, or a group of mobiles, the 
behavior of the Properties dialog changes.  The following table indicates what 
information is available under each category in both cases: 

 Single Unit Selected Multiple Units Selected 
Details • A summary of mobile unit 

identification attributes.   

• Most details can be edited 
by changing the value then 
clicking [Apply]. 

• A summary of those attributes 
that are common to all selected 
mobile units. 

• Editing a value will change it for 
all selected mobiles.  This 
allows group reassignments, 
for example to change the 
"Type" attribute on several 
mobiles simultaneously. 

Style • Display style settings for the 
mobile. 

• Styles can be edited by 
selecting the appropriate 
style attribute (icon, symbol, 
size, track) then selecting 
an item on the list and 
clicking [Apply]. 

• Display style settings that are 
common to all selected mobile 
units. 

• Changing a style will apply it to 
all selected mobiles.  This 
allows group assignments, for 
example to change a set of 
icons to the color Red. 

ALC • Displays communications 
settings and configuration 
for a mobile.  

• Settings can be edited by 
changing the value then 
clicking [Apply]. 

• Displays communications 
settings and configuration that 
are common to all selected 
mobiles.  

• Changing a value will apply it to 
all selected mobiles.  This 
allows group assignments, for 
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 Single Unit Selected Multiple Units Selected 

example to change the position 
reporting rate for a group of 
mobiles. 

Input/Output • Displays digital/analog input 
and current status of digital 
outputs.  

• Digital output settings can 
be altered by selecting an 
option from the list then 
clicking [Apply]. 

• Displays digital/analog input 
and current status of digital 
outputs that are common to all 
selected mobiles. 

• Changing a digital output 
setting will apply it to all 
selected mobiles.  This allows 
group assignments. 

People/Org • Displays information on 
People and Organizations 
that have a relationship with 
this mobile unit. 

Not Supported 

Licenses  • Shows licenses/permits 
issued by area.  These 
details are typically 
imported from another 
system.  See your systems 
administrator for details. 

Not Supported 

Alerts • Shows alert history for the 
selected mobile.  Alerts are 
system generated events 
configured by a  

Not Supported 

 
NOTE: Depending on your security settings, you can edit none, some, or all 
attributes of a mobile unit.  If you receive an error "Insufficient Privilege" when 
changing attributes this indicates that access to that attribute has been 
restricted. 



USER REFERENCE MANUAL 

Page 48 
 

© 1995-2001 Absolute Communications Limited.  All Rights Reserved 

 
 

Details  

 
 

The details tab permits viewing and editing of attributes related to mobile 
categorization and identification.  The attributes that can be edited are as 
follows: 

 Description 
Type The type of unit.  The use of this attribute is at the discretion of 

the system administrator.  Typically it is based on either the type 
of mobile asset (car, truck etc) or the usage of the asset. 

Callsign A short identifier for the mobile.  Typically a Car Number, Vessel 
Radio Callsign or similar.  The callsign should be a compact, but 
unique, identifier for the mobile unit. 

 Name The full name of the mobile unit.  This attribute is optional and 
does not need to be unique. 

Max Speed The maximum speed the unit can travel.  Expressed in the 
distance units of the map.  For example; miles/hour if the system 
map being used designates miles, km/hour if the map 
designates kilometers and knots if the map is measured in 
nautical miles.  This setting is required when generating 
Opportunity Ellipses.  It is not required for all other layer types. 

Weight The weight of the mobile  

Length The length of the mobile; in either feet or meters as appropriate. 

 

Click [Apply] to save changes. 

 

NOTE: 

There are several other attributes shown 
that cannot be edited directly.  Most of 
these attributes can be altered outside 
the Properties dialog.   

For example to change the "Country" 
attribute you would use drag-and-drop 
behavior to move the mobile to a 
different country folder. 

The example shown changes the country 
designation to "Belgium". 
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Symbol, Size, Track Thickness & Color 

 
The style tab permits viewing and editing of attributes related to mobile 
display.  The attributes that can be edited are as follows: 

 Description 
Icon The symbol (icon) that marks the location of a mobile 

Color The color of the icon and track display for a mobile 

 Size The size of the icon 

Track The line thickness of the track 

 

To change a style, select one of the four attributes and make a selection from 
the list.  To save the changes either double-click on the new selection, or 
select [Apply].   

If the units selected are presently drawn on the map, the display will redraw 
with the new styles. 

NOTE:  If any of the style attributes is the same for all selected mobiles the 
current setting is displayed, otherwise a generic "*" symbol is displayed. 
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Automatic Location Communicator Settings 

 
The ALC (Automatic Location Communicator) tab permits viewing and editing 
of communications configuration parameters.   

For details on configuring the Reporting Rates (the top section) please refer 
to Sending Commands to Mobile Units. 

The other parameters describe how the mobile unit is identified.  Different 
wireless and satellite networks require different combinations of identifiers.  
The definition of each identifier is as follows: 

 Description 
Unit # A unique identifying number for the mobile unit.  This field is 

generally used where no other identifier is available. 

Pfix Prefix; used on Trunked Mobile Radio Networks 

 Ident Ident; used on Trunked Mobile Radio Networks 

TCPIP TCP/IP address in format "x.x.x.x".  This is used by mobile units 
that have wireless internet addresses 

IMN Inmarsat Mobile Number.  Uniquely identifies mobiles that 
operate on the Inmarsat network. 

LES Inmarsat Land Earth Station (LES) code.   

DNID Inmarsat Data Network Identifier.  Indicates the group to which a 
mobile belongs on the Inmarsat network for position reporting 
purposes. 

Mem# Inmarsat Member Number.  Identifies a mobile uniquely in 
conjunction with the Inmarsat group (DNID) number. 

EMail An Internet e-mail address.  This type of address is used by 
mobiles that operate on a wireless internet system that supports 
e-mail. 

Phone A phone number.  Uniquely identifies mobile units that use the 
cellular network for communications. 
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The combination of identifiers to be entered depends on the type of tracking 
device and how the system is configured.  

NOTE: The following table is intended as a guideline only - your systems 
administrator may have altered the default settings in this regard. 

Select the type of tracking device from the left column.  The identifiers that 
should be entered, based on the tracking device type, are shown below: 

 Unit # Pfix & 
Ident 

TCPIP IMN LES DNID & 
Mem # 

E-Mail Phone 

GSM Cellular O       M 
AMPS Cellular M       M 
Cellular Packet Data O  M      
GPRS/GSM Cellular O  M     M 
Inmarsat-C O   M O M  O 
Inmarsat-D+    M     
Argos M        
Trunked Mobile Radio  M       
Orbcomm        M 
Private Radio 
Network 

M        

 

• M = Mandatory.  This field must be entered. 

• O = Optional.  This field may be entered.  See the SmartTRAC 
Technical reference material pertaining to the tracking device(s) 
in use for the system for information on whether this field is 
appropriate for your system. 

Communication Channels 
 

If you have multiple types of tracking 
device, the system may be configured to 
support several Communications 
Channels.   

The is indicated by the Channel folder on 
the Filter.  Open this folder to see wireless 
networks are available for communication 
with mobile units. 

If you make changes in the Properties 
dialog that alter which network a given unit 
communicates via, you must also update 
the Channel. 

An example is substitution a cellular 
tracking device with a satellite transponder 
on a given mobile unit.  In this case edit 
the mobile details in the Properties dialog 
then use the Unit List and Filter to reassign 
the mobile to the correct channel - in this 
example the "Inmarsat : Comsat" folder. 
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Input and Output Sensors 

 
A system can be configured with input and output sensors.  These are 
connected to external devices on the vehicle.   

For a complete description of controlling output lines please refer to the 
section Sending Commands to Mobile Units. 

The two types of sensor available are: 

 Description 
Inputs A list of inputs defined for this system with values shown.  

If no value is indicated then the particular mobile unit selected 
does not have this sensor type installed. 

Outputs Digital output lines configured for use with the system.  If no 
value is shown then the status of this output line is unknown. 

 

After changing an output value, click [Apply] to send the appropriate 
commands to the mobile unit. 
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People and Organizations 

 

The People and Organizations tab shows particular associations between a 
person/organization and a particular mobile unit.  The nature of the 
association is referred to as a "Role".   

Roles are system specific but typically include definitions such as 
"Driver","Owner" and "Agent". 

The top portion of the display indicates a list of all organizations (folders) and 
people (icons) that have some relationship with this mobile unit.  If your 
systems administrator has imported hierarchy information then the 
association of people within their respective organizations is also displayed.   

The details available are: 

 Description 
Name The name of the person or organization 

Address The address, phone and fax numbers for the person or 
organization 

Roles A list of one or more roles.   
The left hand column (description) is the mobile unit that the role 
relates to and the right hand column defines the type of 
association. 
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Licenses 

 

The Licenses tab shows licenses or permits issued to mobile unit.  A date 
range and a status identify each license.  Status codes are as follows: 

• A white license indicates a current status 

• A gray license has expired 

• A license with a cross mark has been cancelled 

Selecting a license displays additional details.  The exact details are defined 
by the system administrator, so your display may appears slightly different to 
the example shown here.  In most cases the details available will include: 

 Description 
From Date the license comes into effect 

To Date the license is valid until 

Cancelled Cancellation date for the license 

Trip A trip identifier, if this is a single use license 

Areas A list of geographic areas where the license is valid 

Restrictions Designations of restrictions on the license; i.e. hours of 
operation, types of fishing gear.  The exact interpretation of these 
attributes is dependent on the system configuration. 
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Alerts 

 
Alerts are generated in relation to significant activity or events.  Almost any 
activity on the system can be configured to trigger an Alert.  For further details 
on configuring Alerts and how they operate please refer to the Configuring 
Alerts section of this manual. 

When an Alert is generated all details are stored in the database. The Alerts 
tab is then used to review details on alerts received for a specific mobile unit.  

 

NOTE: A summary of the most recent 
Alert for each mobile is displayed on the 
Filter and Unit List.  These tools can be 
used to monitor activity in relation to the 
status of a mobile. 

 

 

Details available for each Alert include: 

 Description 
Alert Type of alert.  Described in the following table. 

Priority Priority assigned to the alert by the system administrator. 

Detected Date that the activity causing the alert commenced.  This may 
not be the same as the date the alert was issued, as the alert 
could relate to older data that was downloaded (i.e. from a 
logfile) at a later date. 

Details Alert specific details, provides additional information based on 
the specific type of alert. 

 

NOTE: Before Alerts will be generated the Alerting System must be 
configured.  See the Configuring Alerts section for details on this process.
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Alerts are categorized according to a hierarchy.  The first portion is system 
category and describes the general nature of the alert.  Each portion of the 
Alert Code is then separated with a "." (full stop) and describes in 
progressively more detail the exact nature of the Alert. 

To check which Alerts are supported on a given system configuration, 
perform the following steps: 

 

• Open the Alert Configuration 
from [Tools]Æ[Alert Properties]  

• Click on [New…] 

 

 

 

 

 

 

• Expand the [Event] folder.  By 
concatenating the folders in this 
view the Alert Code can be 
established.  

• For example; the "Stop" item 
shown here has an Alert Code 
of "Command.Sent.Stop" 
formed by concatenating the 
"Stop", "Sent" and "Command" 
folders. 

 

 

 

A description of the Alert Categories is as follows: 

Type Description 
Command.Sent A command, reprogramming a mobile unit, was 

transmitted 
Command.Ack A command, reprogramming a mobile unit , was 

successful 
Command.Failed A command, reprogramming a mobile unit, failed 
Position The alert relates to a status received in relation to a 

position report.  For example; Power On, Power Off.   
The exact list of status codes supported is system 
specific. 

Position.Unknown Unit A position report was received from an Unregistered 
mobile.  This can happen where a new transponder has 
been commissioned but not yet added to the system.  
The final portion of the alert code is as per the Position 
alert. 

Messages Send/Received/Failed indication on the transmission of a 
text message (e-mail) to or from a mobile. 

Speed.Stationary The mobile unit is stationary 
Speed.Slow The mobile is moving within the "slow" speed range.  This 

threshold is configured by the systems administrator. 
Speed.Fast The mobile is moving in the high speed range. 
Speed.Exceeds 
Maximum 

The mobile has exceeded the maximum speed specified 
in the Details tab on the Properties Dialog. 

Area.Entry The unit has entered a defined area 
Area.Exit The unit has exited a defined area  
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Type Description 
Area.Within The unit has reported a position with a defined area  
Overdue The unit has stoped reporting at its programmed rate.  

The digits after the alert indicate the tolerance; i.e. 01:00 
indicates one hour. 

 

Adding and Deleting Mobiles 

Adding a Mobile to the Fleet 
 

 
New mobile units are added to the system by right-clicking on the Unit List and 
selecting the [New…] option.   
 
This creates a new mobile, and opens the Properties dialog so you can enter values 
for the mobile unit and its wireless or satellite network communications configuration. 
 
For details on setting these mobile attributes refer to the preceding section: Viewing 
and Editing Mobile Details. 

Default Values 
 

If a Filter has been specified for the Unit List, those attributes are filled in 
automatically when a new unit is created. 
 
For example; 
 

• Selecting a filter criteria of "Type"="Trucks" and "Update Rate" = 
30 minute filters the Unit List. 

• Selecting [New] will create a new mobile, of type "Truck" with a 
reporting rate of 30 minutes. 

Adding Many Units 
 

When entering details for many units many attributes may be the same, or 
similar.  For example;  
 

• The type, size (length)  

• The style (icon, size, thickness) 

 
Rather than enter these individually for each unit, use the following process: 
 

• Create each new unit 

• Enter only the details that are different for each unit (i.e. the name 
and mobile unit identification numbers) 
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• When complete, select all the new units in the Unit List.  The 

Properties dialog will change to the group mode. 

• Set the relevant attributes for the entire group. 

 
 

Deleting a Mobile 
 

 
 

To delete an existing mobile; 
 

• Select the mobile in the Unit List 

• Right-click and select "Delete" 

• You are asked to confirm the deletion 

 

NOTE: 

 

• Depending on system configuration deleting a mobile may not remove 
track data or other information from the database as indicated. 

• If the system is configured with an Oracle Database, and auditing is 
enabled, this function marks the mobile as inactive and removes it form 
the display.  In this configuration only systems administrators can 
permanently delete data. 

• If you delete a mobile unit in error, ask your systems administrator to 
restore the deleted unit for you (this is only possible on systems 
configured with auditing enabled). 
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Creating Custom Groups of Mobiles 
 

If you frequently work with a group of mobiles that aren’t included in a 
standard SmartTRAC group you can create a personal group to store the 
mobiles in: 

 
• Right-click on the Filter, choose the [New] 

option and select [Group]. 

• A new group appears in the Filter. 

• Type a name for the group, then click 
elsewhere in the Filter. 

• The group is created and contains a single 
Unknown category containing all mobiles. 

 
 
 
You then create categories within the group: 

 
• Click (select) the group to add a category 

to.  

• Right-click in the Filter window, choose the 
[New Category] option. 

• A new category appears in the Filter 
window.  

• Type a name for the category, then click 
elsewhere in the filter. 

 

To select which units are in each group: 

• Click and drag the units of interest into the 
category folder.  

• You can also drag category folders from 
other groups, to place the entire contents 
of another category into this one. 

 
 
 

The new group and categories are stored when 
you exit and also shared with other users.  
 
NOTE:  If other users add new categories these do 
not appear on your display until you next restart 
SmartTRAC Workstation.   
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Customizing the Map Display 

Layer Settings 
 
The map display is created from a series of layers.  Each layer is like a 
transparent sheet, with a specific type of information drawn on it.  The layers 
stack from bottom to top, with information in upper layers drawing over lower 
ones. 
 
The topmost layers contain the track and position information that 
SmartTRAC draws on the display.  Layers below this are defined by your map 
supplier and will vary according to the type of map you are using. 
 
Layers can change visibility at different zoom levels.  For example showing 
street names on a map of the entire world would not be feasible, but as you 
zoom in on the map display it becomes appropriate for this layer to become 
visible.  The technique used to achieve this style of display is called zoom-
layering.  You can change the settings at which each layer displays, and 
customize many display options, through the Layer Settings dialog. 
 
When you open the Layer 
Settings dialog it will display the 
list of layers on the map.  Layers 
with the following names are 
reserved for exclusive use by  
SmartTRAC: 
 

• Location 
• Positions 
• Track 
• Sightings 

 
You can change the order in which layers are displayed by either: 
 

• Clicking and dragging the layer up or down  
• Clicking on a layer, and using the [Reorder] options 

 
Beside each layer are four icons with checkboxes.  These control the major 
attributes of the layer.  From left to right the checkboxes are: 
 

• Visibility: Indicates that this layer is visible.  A purple 
checkmark indicates that the layer is visible, but at the present 
map scale it has been turned of due to zoom-layer settings.   
 
You can turn layer visibility off to reduce screen clutter, however 
do not disable visibility on SmartTRAC reserved layers.  Instead 
use the [Analyze] menu options to enable/disable SmartTRAC 
content. 
 
To alter visibility settings; click on the 
[Display…] button.  This opens the 
Display Options dialog for the 
selected layer.   

• Use [Style Override] to override 
the display style for all objects on 
the layer. For example; to force 
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all objects on the layer to display in Blue. 

• Use Zoom-Layering to specify the minimum and maximum 
zoom level for this layer. 

• Edit: When you draw an object with the [Draw] menu tools, 
the Editable layer is where the object is saved.  Unless you intend 
to modify map data permanently, it is safest to make only the 
"Cosmetic Layer" editable.  The Cosmetic Layer is like a 
scratchpad, you can use it to draw objects on a temporary basis 
without affecting the map files.  NOTE:  If the edit option is grayed 
out, the layer is read-only and you do not have permission to edit 
it. 

• Select: Indicates this layer can participate in operations with 
the Select tools.  Occasionally it is desirable to disable selection 
on a layer, so objects from a lower layer will be selected instead.  
For example; disabling selection on the "Location" layer is 
necessary when copying position data from the "Positions" layer.  
This is because the "Positions" layer is normally below "Location" 
layer in the selection order.   

• Auto-Label: If this checkbox is on, labels are drawn 
automatically for all objects in this layer.  If not checked, labels 
are drawn only when an object is clicked on with the Label tool.  
 
As with the Visibility option, a purple checkmark indicates that 
Auto-Labeling is active, but labels are not currently drawn due to 
zoom layering. 
 
To change labeling 
options, click on the 
[Label…] button.  This 
displays the label option 
dialog.    

• Use the Visibility 
options to determine 
when the layers are 
visible, and how 
overlapping labels 
should be handled. 

• Use the Style options 
to set the font size 
and color. 

• Use the Position 
options to specify the 
label location and offset from the object (e.g. below, and 
offset by 4 points). 

• The "Label with…" list shows the fields that can be used for 
the label.  The available selection varies according to the 
specific layer and map provider.  You can also create  
composite labels from many fields by selecting the 
"Expression…" option.  This displays the expression dialog. 

• To enter an 
expression, select all 
fields required from 
the "Columns" box. 
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• Concatenate fields with the ’+’ symbol 

• To put a space between two fields use the ’+ " " + ’ 
syntax; for example; Date+" "+Time 

• To make a multi-label line, insert the expression 
chr$(13).  This adds a new line to the label. 

• For example; Name + chr$(13) + Date + " "  + Time 
creates a composite label on two lines using the name of 
the mobile and the date and time of last report. 

Map Properties 
 

The Map Properties dialog displays the current presentation attributes for the 
map.   
 
• Use the Coordinate Units list to specify 

the measurement units.  To display all 
coordinates in the  
Degrees/Minutes/Seconds notation, 
also select the "Show DMS" checkbox. 

• The distance and area units specified 
are used by SmartTRAC for speed 
calculations.  The speed unit that 
SmartTRAC will select is related to the 
distance measurement unit as follows: 

• Miles  = Miles/hr 

• Kilometers = Km/hr 

• Meters  = Meters/second 

• Nautical Miles = Knots 

• The Projection allows you to specify the type of map view.  For example 
the first example is a Latitude/Longitude view, the second shows the 
Projection of the world from the North Pole. 

 

NOTE: The "Display in Status Bar" options are not supported by  SmartTRAC.  
SmartTRAC will always display its own status bar instead of the options 
specified in this dialog.  

Changes in this dialog apply only for the current session unless you save the 
map as a new template Workspace (Map) file.  To save a Workspace file: 
 

• First turn off all SmartTRAC layers through the [Analyze] menu (e.g. 
Positions, Location, 
Tracks, Sightings).  
You will know that all 
layers are disabled 
when the following 
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dialog appears: 

• Use the [File]Æ[Save As…] menu to specify a name for this Map 
Workspace.  Once the Workspace is saved, you can reopen it later 
with [Open] and all the options specified for the map display will be 
activated. 

• Re-enable tracking layers through the [Analyze] menu. 



USER REFERENCE MANUAL 

Page 64 
 

© 1995-2001 Absolute Communications Limited.  All Rights Reserved 

 
 

Drawing and Annotating on the Map 

Overview 
 

The options in the Draw menu can be used to add custom 
text, symbols and simple graphics to any layer in the map.  
 
NOTE: If these tools are shown on your system grayed out 
then you must first select a layer to edit, please refer below. 
 
Editing a layer creates a permanent change to the map and for this reason 
only administrative users are normally permitted to edit layers.  To see which 
layers are editable on your system, open the [Select]Æ[Layer Settings] dialog.  
Layers that have a white checkbox under the Pencil symbol can be edited.  
Other layers are read-only and cannot be altered. 
 
Only one layer can be selected for editing.  Making a layer as editable 
removes the checkbox from the previously selected editable layer. 
 
It is most common to create temporary 
objects, known as annotations, on a 
map.  For this purpose the drawing 
tools are used, but rather than altering 
the underlying map the editing is 
performed on the "Cosmetic Layer". 
 
The Cosmetic Layer is analogous to a 
scratchpad or overlay on top of the 
map window.  It is the only layer that 
can be used for used for making 
annotations on the map.  The annotations can still be saved as a separate file 
using [File]Æ[Save As…] but drawing objects on the Cosmetic Layer do not 
affect the underlying map base. 
 
If the Cosmetic Layer is not editable, select the checkbox shown above and 
click [OK].  The drawing tools will then be enabled. 

The Snap Option 
 
Often when using drawing tools it is desirable to create a new object based in 
part, or located relative to, an existing drawing object or feature of the map 
(i.e. a street, or a coastline).  The "Snap" function provides a convenient way 
to trace objects of the map as part of a new object.   
 

• To enable Snap press "S" while using any drawing tool.  The 
mouse cursor will indicate with crosshairs the closest existing 
map object under the cursor.  When you click to define a point in 
the new object, the location is "snapped" to the location of the 
crosshairs. 

. 
• To disable Snap press "S" again. 
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Drawing Tools 

Text 
 

Select the [Text] tool from the [Draw] menu: 
 

• Click on the map to place a text label 

• Type text directly onto the Map 

 
A text object that has been placed can be edited later: 
 

• Use the [Select]Æ[Pointer] menu option to change to the 
selection tool. 

• To move the label to a 
different location, click 
on the label and drag it 
to a different part of 
the map.  A line is 
drawn back to the 
original point of origin. 

• To edit, rotate, or 
change the style of a 
label double-click on 
the label to display the 
Text Object dialog box.  

 
NOTE: You can specify the default style, font, size etc for all new text 
objects by selecting the [Draw]Æ[Drawing Style]Æ[Text] menu option.  
This opens the [Text Style] dialog box. 
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Symbol 
 

Select the [Symbol] tool from the [Draw] menu: 
 

• Click on the map to place a symbol 

 
A symbol object that has been placed can then be edited: 
 

• Use the [Select]Æ[Pointer] 
menu option to change to the 
selection tool. 

• To move the symbol to a 
different location, click and 
drag it to a different part of 
the map.  

• To change the symbol type 
double-click on the symbol to 
display the Point Object 
dialog box.  

 
NOTE: You can specify the default style, font, size etc for all new 
symbol objects by selecting the [Draw]Æ[Drawing Style]Æ[Symbol] 
menu option.  This opens the [Symbol Style] dialog box. 
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Lines, Polylines and Arcs 
 

To draw a line between two points on the map, select the [Line] tool 
from the [Draw] menu: 

• Click on the map at the starting position for the line and hold 
the mouse button down.  

• Drag the line to the ending 
position and release the 
mouse button. 

• Press [ESC] at any time to 
cancel. 

• A line object can be edited later by choosing the [Select] Æ  
[Pointer] tool, then double clicking on the line. 

 

To draw an object comprised of many line segments; select the 
[Polyline] tool from the [Draw] menu: 

• Click on the map at the starting position for the polyline and 
release the mouse button. 

• Move to the first point along 
the line and click.  

• Repeat until all line segments 
have been placed.   

• Double click to complete 
drawing the line.  

• Press [ESC] at any time to 
cancel. 

• A polyline object can be edited later by choosing the [Select] 
Æ  [Pointer] tool, then double clicking on the polyline. 

 

To draw an arc between two points; select the [Arc] tool from the 
[Draw] menu: 

• Click on the map at the starting position for the arc and hold 
the mouse button down. 

• Drag the line to the ending 
position and release the 
mouse button.  

• Press [ESC] at any time to 
cancel  

• An arc object can be edited 
later by choosing the [Select] 
Æ  [Pointer] tool, then double clicking on the arc. 

 
NOTE: You can specify the default style, font, size etc for all new line, 
polyline and arc  objects by selecting the [Draw]Æ[Drawing 
Style]Æ[Pen] menu option.  This opens the [Line Style] dialog box. 
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Rectangles, Rounded Rectangles, Regions and Circles 

 
To draw a rectangle or rounded rectangle on the map, select the 
[Rectangle] tool from the [Draw] menu: 

• Click on the map at the starting 
position for the rectangle and 
hold the mouse button down.  

• Expand the rectangle to the 
desired size and release the 
mouse button. 

• Press [ESC] at any time to 
cancel. 

• A rectangle object can be edited later by choosing the 
[Select] Æ  [Pointer] tool, then double clicking on the 
rectangle. 

 

To draw a region comprised of many segments; select the [Region] 
tool from the [Draw] menu: 

• Click on the map at the starting position for the region and 
release the mouse button. 

• Move to the first point along the 
line and click.  

• Repeat until all segments have 
been placed.  

• Double click to complete 
drawing the region.  The last 
two points are joined to 
enclose the shape.  

• Press [ESC] at any time to cancel. 

• A region object can be edited later by choosing the [Select] Æ  
[region] tool, then double clicking on the region. 

 

To draw a circle between two points; select the [Circle] tool from the 
[Draw] menu to draw an object comprised of many line segments. 

• Click on the map at the starting position for the arc and hold 
the mouse button down.  

• Drag the line to the ending 
position and release the 
mouse button.  

• Press [ESC] at any time to 
cancel  

• An arc object can be edited 
later by choosing the [Select] Æ  [Pointer] tool, then double 
clicking on the arc. 
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Converting Objects 
 

After objects have been drawn they can be converted from one format to 
another using the tools located under [Draw]Æ[Object…] 

Combine 
 

Several objects can be drawn individually, then combined into a 
single object. This function is used to construct complex shapes that 
represent a combination of different tool types, i.e. rectangles, circles 
and regions. 

To combine objects: 

• Draw objects onto the map 

• Choose the [Select] Æ  [Pointer] tool 

• Click on the first object to be combined (grouped) 

• Hold down the [Shift] key and select additional objects 

• Select [Draw]Æ[Object…]Æ[Combine] 

All individual objects are now combined into a single composite 
object.  The object can now be selected, moved or edited as a single 
item. 

Convert to Polyline 
 

Rectangles, Regions and Circles can be converted from an enclosed 
(filled) object to an outline (polyline) through this tool.  To convert: 

• Choose the [Select] Æ  [Pointer] tool 

• Click on the object to be converted 

• Select [Draw]Æ[Object…]Æ[Convert to Polyline] 

• The object is converted into the equivalent polyline 
(outline) representation. 

• NOTE: If this option is grayed out then the object type 
selected does not support conversion to a polyline.  
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Convert to Region 
 

Polylines can be converted from an outline object to a filled region 
object.  To convert: 

• Choose the [Select] Æ  [Pointer] tool 

• Click on the object to be converted 

• Select [Draw]Æ[Object…]Æ[Convert to Region] 

• The object is converted into the equivalent region 
(enclosed) representation. During this process the start 
and end point of the polyline are joined, to create the 
enclosed shape. 

• NOTE: If this option is grayed out then the object type 
selected does not support conversion to a region. 

 

Buffer 
 

A buffer is a region object created around one or more other objects 
on the map.  The buffer represents a set distance from these objects 
and can be used in several situations, including: 

• Creating areas that 
follow a set route, with 
a specified degree of 
tolerance.  For 
example a 250 meter 
corridor along 
Broadway, New York.   

 

 

• Creating a buffer 
around a land feature, 
such as an island.  
For example a set of 
islands in the 
Hawaiian Island 
chain. 
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To create a buffer: 

• Choose the [Select] Æ  
[Pointer] tool 

• Click on the first object to be 
included in the buffer 

• Optionally, hold down the 
[Shift] key and select 
additional objects 

• Select 
[Draw]Æ[Object…]Æ[Buffer] 

• The Buffer Objects dialog is 
displayed.   

• Select the Value (i.e. 12) and the distance units (i.e. 
miles) of the buffer.  

• The Smoothness value dictates the accuracy of the 
buffer.  Higher values give a more accurate result, but 
the function operates more slowly. 

• Other options on this dialog should be left at their default 
values. 

• Click [OK] to create the buffer. 
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Configuring Alerts 

Concepts 
 

An alert can be automatically generated by SmartTRAC when any mobile unit 
behaves in an unexplained or potentially suspicious way.   For example, when 
a unit travels into a restricted zone, or stops for a prolonged period of time.  

 
In SmartTRAC Workstation Alerts are viewed through the Properties dialog. 
Features are also provided within the Alerting system to forward alerts via e-
mail and pager to recipients.  In this case incoming alerts are listed in the mail 
program’s window just like ordinary e-mail messages.  Alert messages can be 
read, printed and forwarded just like ordinary mail messages too. 
 

Architecture of the Alerting System 
 

Event
(i.e Position Report
from Mobile Unit)

Is Alert
Triggered?

Alerts
Actions to Take when

Alert Triggered

Commands to Mobile
Units (i.e. change

reporting rate)

Alert Criteria
(Business Rules)

Execute Alert Actions
Style Changes (i.e

change Icon to Red)

E-Mail & Pager
Notifications

Alert Generated and Stored in Database
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Events 
 

An event is generated in relation to almost any transaction on the 
SmartTRAC system.  However not all Events generate Alerts.  This is 
because Business Rules are defined to filter most Events out - 
leaving only those of most interest. 

 

Business Rules 
 

A Business Rule defines the circumstances under which an Event 
becomes an Alert.  Each Rule handles one or more Events, and 
considers these in conjunction with Filter Criteria. 
 
A Business Rule examines an event to determine whether: 
 

• The Event is of a type handled by this Rule 

• The Date and Time of the Event is within the range 
specified for this Rule 

• The Mobile Unit is part of a group selected for this Rule 

 
The result of the evaluation is always a YES or NO outcome.  If the 
outcome is YES then an Alert is generated.  If NO then no further 
action is taken (the Event is ignored). 
 

Actions 
 

An Action is a set of steps taken in response to an Alert.  Almost any 
type of activity that can be performed through SmartTRAC 
Workstation can also be executed automatically.  
 
Actions include: 
 

• Reconfiguring the mobile unit’s reporting rate, 
downloading a log file or requesting an updated position. 

• Sending a text message to the mobile unit 

• Changing the value of a digital output control 

• Setting the style of icon and track display (i.e. changing 
the Icon to Red when a panic button is pressed) 

• Sending e-mail or pager notifications 
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The Alert Configuration Tool 
 
To create, edit and delete Alerts open the Configuration Tool.  
 

• Select [Tools]Æ[Alert 
Properties…] 

• This displays the current 
list of Business Rules 
(under the Alert section of 
the tree), and 

• The current set of Actions 
(under the Action section 
of the tree) 
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Business Rules 
 

To define a new Business Rule; 
 

1. Click on the [New…] item under the [Alerts] folder.  This will 
open a dialog to define the criteria. 

2. Change the attributes as described below, and click on [OK] 
when finished.  You are then given the opportunity to name the 
Business Rule.  Select a name that describes the intent of the 
rule; i.e. "Detect Unit Failures", "Entry to Prohibited Area". 

3. You can rename or edit existing rules in the same way.  Just 
double click on the rule to view it, or select the rule and click 
[Rename] to change the label. 

Events 
 

The simplest Rule is one that  
specifies a set of Events that 
will generate an Alert.   

More complex rules still 
require a set of Events as a 
base. 

• To specify which Events 
will trigger the alert, open 
the folders and browse 
for the correct Event(s). 

• You can select any 
number of Events. 

 

NOTE:  For a definition of the Event Codes please refer to the Alerts 
section of this manual.  
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Date Range 
 

Rules can filter the events based on the date and time: 

• Select whether to 
trigger if the Events occur 
within (Include) or outside 
(Exclude) the specified 
date range. 

• Specify the date and 
time range and whether 
the settings are in UTC 
or local time. 

• The time period can 
also be set to repeat 
each day, for example so 
that the Alert Triggers 
only after-hours during 
summer months. 

 

Applying Alerts to Specific Mobiles 
 

Rules can filter the events so they are only applicable to specific 
mobiles, or groups of mobiles: 

• Select the "[Unit]" option 
to filter by a set of 
individual mobiles. 

• Select the "[Group]" 
option to filter by a group 
of mobiles.  

• These tools operate the 
same way as the Filter in 
the main window (i.e. you 
can use the [Ctrl] key to 
select multiple groups). 
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Defining Geofences 

 
Several categories of Event are concerned with movement of mobile units 
between areas.  Specifically the Area.Entry, Area.Exit and Area.Within 
Events.   
 
Before it is possible to generate Alerts in these categories the appropriate 
areas must be drawn.  An area used to monitor the behaviour of the fleet is 
called a Geofence.  
 
Geofences can be drawn in two ways: 
 

• In a Geographic Information System package such as MapInfo 
Professional.  The areas can then be imported into SmartTRAC 
for use in Alerting.  Discussion of this topic is outside the scope of 
the User Manual and is covered instead by the Systems 
Administrator material for SmartTRAC. 

• Directly in SmartTRAC Workstation.  This is suitable for simple 
types of geofence - such as a rectangle, circle or a simple area.  
This procedure is described here. 

NOTE: Not all systems are configured for GeoFencing.  If you are unable to 
access the Area layer described below then GeoFencing is not enabled.  See 
your systems administrator for information on configuring the SmartTRAC  
Map Workspace to include the Geofence layer. 

Making the Area Layer Editable 
 

 

• Choose [Select]Æ[Layer Settings] to show the Layer Control 
Dialog. 

• Click on the checkbox under the Pencil symbol to make the Area 
layer editable.  This layer is where all Geofences are defined. 

NOTE: If you can see the Area layer, but the checkbox is grayed out 
then the security settings for your account do not permit editing of 
geofences. 
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Defining the Geofence Area 
 

To create a new Geofence use the drawing tools to define an area on 
the map.  Refer to the section Drawing and Annotating on the Map for 
further details on the use of each type of drawing tool. 

Only the following tools can be used to create Geofences: 

• Rectangles 

• Circles 

• Regions 

• Region objects produced through use of the Buffer tool 
([Draw]Æ[Object…]Æ[Buffer]) 

• A combination of any of the above through use of the 
Combine tool (([Draw]Æ[Object…]Æ[Combine]) 

• NOTE: Other drawing objects are not suitable because 
they do not have an area that a position can be tested to 
determine whether it is inside or outside.  For this reason 
objects such as lines, text or symbols cannot be used as 
part of a Geofence. 

Changing the Geofence Style 
 

Because Geofences sit on top of all other layers it is important that 
they are transparent.  This allows the map display below the 
Geofence to remain visible even though the Geofence overlays the 
map. 

To make a Geofence transparent, double click to bring up the 
Properties Dialog: 

 

• Click on the [Style] setting 

• Change the [Fill Pattern] to N 
(None). 

• You can also specify other style 
settings to indicate what type of 
geofence you are drawing; i.e. Red 
for Prohibited Areas, Green for 
Safe Zones.  

• The Sample section at the bottom 
of the dialog indicates 
approximately how the new 
Geofence will look on the map. 
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Naming and Numbering the Geofence 

 

To work with the Alerting system each geofence must have a name 
and number assigned.   

After you have drawn the object select the [Analyze]Æ[Info] tool and 
click on the newly defined Geofence.  This will display the Info Tool.   

If the map is cluttered you may need to select the "Area" row first, 
then the following dialog should be displayed. 

 

• Enter a number into the Area_Id field to uniquely identify this 
Geofence.  This number can be anything that is meaningful - a 
route number or simply an ascending sequence; 1,2,3… 

• Enter an Area_Type.  This is optional, if entered it can be used 
later during display and reporting to separate different types of 
Geofence. 

• Enter a name for the Geofence.  This name is used by the 
Alerting System.  

Modifying an Existing Geofence 
 

• To modify the attributes of an existing Geofence use the Info tool 
in the same manner as for a new Geofence. 

• To modify the geography (i.e. to move the geofence on the map) 
use the [Select]Æ[Pointer] tool to select the object then drag it to 
a new location.  

• The exact location can be specified by double-clicking and typing 
coordinates into the dialog box. 

Deleting a Geofence 
 

To delete a geofence: 

• Use the [Select]Æ[Pointer] tool to select the object.   

• Select [Edit]Æ[Cut] (or) 

• Press the [Delete] key. 
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Alert Actions 

 
NOTE: If you previously worked through the GeoFencing section, return now 
to the Alert Configuration screen by selecting [Tools]Æ[Alert Properties….] 
 
To define a new Action; 
 

• Click on the [New…] item under the [Action] folder.   

• Change the attributes of the Action as described below, and click 
on [OK] when finished.   

• You are then given the opportunity to name the Action.  Select a 
name that describes what happens when this action executes; 
i.e. "Page Shift Supervisor", "Set Reporting Rate to 15 minutes". 

• You can rename or edit existing actions in the same way.  Just 
double click on the rule to view it, or select the rule and click 
[Rename] to change the label. 

 

Changing Mobile Reporting Rates 
 

 
An Action that changes the Reporting Rate operates in the equivalent 
manner to changing a reporting rate, requesting a position update, or 
downloading a logfile from a mobile within Track Explorer. 
 
For details on performing these functions refer to the section Sending 
Commands to Mobile Units. 
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Sending a Message to a Mobile 

 
A message can be issued to the mobile unit that generated the Alert.  
 
The text in the message consists of literal text and macro 
expressions that are expanded from the Alert itself and other relevant 
data.  The full list of Macro expansions is available from the drop 
down dialog.   
 
Macro expressions are grouped according to type.  The table 
following includes the most common macros.  Items with an "*" 
indicate that several formatting options are available; select from the 
drop down list to view the available formats: 
 

ID The unique identification number for this Alert 
Type Type of Alert.  Refer to the Alerts section for further information 
Priority The configured priority for this type of Alert 
Detected.* Date & Time of Event.   

Versions with UTC are the UTC/GMT date/time. 
Description Additional parameters related to the specific Alert generated 
Action.Name The name of the Action being executed 
Filter.Name The name of the Business Rule that triggered the Alert 
Msg.Sent.* Date/Time the Message was sent from the Mobile Unit 
Msg.Processed.* Date/Time the Message was processed by the Wireless 

Network 
Msg.Delivered.* Date/Time the Message was processed by SmartTRAC 
Msg.Text Text message (only for e-mail/text messages to/from mobile 

units) 
Pos.Lat.* Latitude at time Alert was generated 
Pos.Long.* Longitude at time Alert was generated 
Pos.Altitude.* Altitude at time Alert was generated 
Pos.Prev.* As for Pos, but for the previous position received before the 

Alert 
Pos.AveSpeed.* Average speed of the mobile, in a variety of measurement 

units 
Pos.AveHeading Average course-over-ground of the mobile 
Pos.Type The type of position code.  Refer SmartTRAC Information 

Layers  
Area.Name Area the mobile entered/exited (if this is an area related Alert) 
Unit.Callsign The callsign of the mobile unit (as displayed on the Unit List) 
Unit.Name The name of the mobile unit (as displayed on the Unit List) 
Unit.Type The mobile type (as displayed on the Unit List)  
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Changing Digital Output States 

 
 

An Action defined to change the Digital Output lines operates in the 
equivalent performing this function within Track Explorer. 
 
For details on performing these functions refer to the section Sending 
Commands to Mobile Units. 

 

E-Mail Notification 

 
An Alert can be e-mailed to one or more recipients.  Click on the [To] 
and [Cc] buttons to indicate where this action should send the Alerts.   
 
As with messages sent to a mobile unit the text of the e-mail can be 
configured with Macro Expressions.  Refer to the Sending a Message 
to Mobile section on previous pages for details. 
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Cellular/Pager Notification 

 
An Alert can be transmitted via pager or cellular phone.   
 
NOTE:  If your cellular or pager provider has an e-mail gateway then 
use the preceding section to configure transmission to an e-mail 
address.  Use this section only if your system is configured with a 
direct wireless gateway for Short Messaging Services.  See your 
systems administrator if you are unsure which method to use. 
 
Enter the cellular phone number to transmit the message to.  For 
some older GSM (European & Asian) cellular networks and phones it 
is also necessary to specific the Short Messaging Service Center 
number.  See the Short Messaging or Text Messaging documentation 
from your cellular provider for details. 
 
As with messages sent to a mobile unit the text can be configured 
with Macro Expressions.  Refer to the Sending a Message to Mobile 
section on previous pages for details. 
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Setting Actions to Trigger from an Alert 
 

After you have defined Actions, they can be linked to the Business Rules 
defined in the Alerts section.  To do this: 

 

• Open the [+] folder beside the Rule in the [Alerts] folder 

• The Actions show as a set of checkboxes 

• Enable or disable the Action by clicking on the checkbox.  The items 
marked with a red checkmark are the Actions that will be automatically 
triggered when the Alert is generated.  

 

NOTE: 

• If multiple actions are defined that alter the same setting (i.e. the 
mobile reporting rate) then the last Action shown in the list takes 
precedence. 

• It is good practice to test a Business Rule before enabling any 
Actions.  When the Alert has been observed to be triggering as 
expected the Actions can be progressively enabled. 

• Think carefully about any Alerts an Action itself may trigger.  For 
example; setting an Alert to detect command failures, linked to an 
Action that itself issued a command is not recommended.  This is 
because such an alert loops; i.e. the alert happens, so a 
command is sent that triggers an alert that sends a command and 
so on. 



USER REFERENCE MANUAL 

Page 85 
 

© 1995-2001 Absolute Communications Limited.  All Rights Reserved 

 
 

How Do I? 

Change the Label Format for Displayed Mobiles 
 

By default, displayed mobiles are labeled with their unit name. You can 
change the label to include one or more of the mobile’s attributes as follows: 

 
• Select Layer Settings from the Select tool menu.  The Layer 

Control dialog appears.  

• Click on the Label button.  The Label Options dialog is displayed. 

• Use the Label with drop-down list box to choose the attribute to 
label displayed mobiles with.  

• Click OK. The Label Options dialog is closed. 

• Click OK. The Layer Control dialog is closed and displayed 
mobiles are labelled according to the new format.  

 
Track Explorer stores the new labeling format when you exit so that it is used 
during future sessions. 

Changing the Units for Distance Measurements 
 

You can change to a different unit of distance as follows: 
 

• Click on the Select menu and choose Map Properties.  The Map 
Options dialog is displayed. 

• Click on the Distance Units drop-down list box and select the 
required units. 

• Click OK to store the settings and close the dialog. 

 
All measured distances are now displayed in the new unit. 

 

Generating Surveillance Reports 
 

Much of the information available in the Track Explorer can be copied into 
other Windows software, for example Microsoft Word, Excel, and Exchange. 
This allows you to quickly include detailed and relevant information in your 
mobile activity reports and e-mails. In particular you can: 
 

• Copy the map display including all mobiles, tracks and labels 

• Copy mobile and alert data 

• Send the details of a mobile in your e-mail messages; just drag 
the mobile of interest from the unit list into the message area of 
the e-mail message 

• Export the map window as a bitmap.  
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Troubleshooting 

Why are the drawing tools unavailable? 
 

The tools in the Draw menu are disabled when the current layer settings are 
such that no map layers can be annotated. You can reset the attributes of one 
or more layers so that they can be annotated as follows; 

 
• Select Layer Settings from the Select tool menu. 

 
The Layer Control dialog appears. The left-hand side of the dialog lists the 
individual layers of your map; the check boxes beside each layer show the 
status of that layer. The column headed by a picture of a pencil indicates the 
status of annotation for a layer; layers that have a tick in this column can be 
annotated. 

 
• Activate on the Annotate check box for the layer you want to 

annotate. 
• Click OK. 
 

The dialog is closed and the tools in the Draw menu are now available. You 
may also need to Save the current workspace if you want these new layers 
settings to be saved for future sessions. 

 

Why can’t I Display Labels? 
 

The Label tool in the Analyse menu can be used to add predefined labels to a 
layer of the map only when layer settings are such that the layer of interest 
can be labelled. You can reset the attributes of one or more layers so that 
they can be labelled as follows; 

 
• Select Layer Settings from the Select tool menu. 

 
The Layer Control dialog appears. The left-hand side of the dialog lists the 
individual layers of your map; the check boxes beside each layer show the 
status of that layer. The right-most column headed by a picture of an address 
label indicates the status of labelling for each layer; layers that have a tick in 
this column can be labelled. 
 

• Activate on the Label check box for the layer you want to label. 
 

• Click OK. 
 
The dialog is closed and the Label tool can now be used in conjunction with 
the updated layers. You may also need to Save the current workspace if you 
want these new layers settings to be saved for future sessions. 
 

 

Why can’t I select Mobiles on the Map? 
 

The Select pointer can be used to select objects only when the layer settings 
for that layer are such that the layer of interest can be labeled. You can reset 
the attributes of one or more layers so that they can be selected as follows; 

 
• Select Layer Settings from the Select tool menu. 
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The Layer Control dialog appears. The left-hand side of the dialog lists the 
individual layers of your map; the check boxes beside each layer show the 
status of that layer. The third from left column headed by a picture of a pointer 
indicates the status of selection for a layer; layers that have a tick in this 
column can be selected. 
 

• Click on the Select check box for the layer you want to select 
objects on. 

• Click OK. 

 
The dialog is closed and you can now select the objects on the updated layer. 
Track Explorer stores the new layers settings when you exit so that they are 
available during future sessions. 
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Installing SmartTRAC and Related Tools 
 

This document describes the process for installing SmartTRAC Workstation 
software on workstations running Microsoft 32 bit operating systems.  
Should you encounter any problem completing this process please refer to 
the technical support documents on the Absolute website at: 
www.AbsoluteCommunications.com 
 
As part of the installation procedure it is recommended that you mark off each 
step in the installation as it is performed.  That way if any step fails you will be 
able to inform technical support of the current status.  In particular, please 
write down the details of any error messages that occur during the installation 
process. 

Pre-Installation Steps 

To begin the installation you will require the following CDs: 

 
• SmartTRAC  

 
You may also have additional CDs that require installation after SmartTRAC 
in order to use the system.  Check for special installation instructions provided 
with the system, as these may include settings for the following items and/or 
installation steps in addition to those indicated here for: 

 
• Oracle 8i (for Oracle based installations only) 
• Map Data CDs from commercial suppliers 

 
 
Please Note:  In order to install SmartTRAC the client machine must have 
Windows 98, ME, NT or 2000 installed.   
 
Minimum hardware requirements are: 
 

• Pentium II 300MHz 

• 64MB RAM 

• 1GB Hard Disk Drive (depending on map data requirements) 

• An 800x600 display resolution 

 
If you are installing the application on a system that is running Windows NT 
Workstation 4.0 or Windows 2000 Professional you must logon on with an 
account that has Administrator rights before commencing installation. 
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 Installing SmartTRAC  
 

• Close any applications that are currently running 

• Insert the SmartTRAC CD and wait a few seconds for the startup screen 
to be displayed. 

 

 

 

• Click on Next> to continue 

• Click on Yes to accept the licensing agreement 

• Unless your IT department has instructed otherwise, click on Next> to accept 
the default location for the destination folder (location of the program folder) 

 

 

 

Select a Setup Type As Follows: 
Multi-User Installation–Workstation: If you are installing a multi-user configuration select this option 
Single User Installation: If you are installing a standalone system select this option 
�

• Click on Next> to continue 
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• Select the program folder that will display the SmartTRAC icons.  Unless your 
IT department has instructed otherwise, click on Next> to accept the default 
program folder. 

• The installation process will now begin.  You should be presented with a 
screen that displays a status bar and the SmartTRAC logo. 

• As part of the installation the MapInfo Run Time setup process automatically 
begins.  

• Enter your name, company and serial number into the next screen then click 
on Next>.  Refer to the CD packaging for serial the serial number.  

�

�
�

• You will be prompted by the next screen to confirm this information.  If is 
correct click on Yes.  If you made a mistake click on No and re-type the 
information.  Repeat this process until you are satisfied it is correct. 

• You will now be presented with the MapInfo Destination Folder screen.  
Unless the client IT department has instructed otherwise, click on Next> to 
accept the default program folder. 

�

�
�

Please Note: If the above screen is not automatically presented to you it could be 
hidden in the background!  If this is the case  <Alt> + <Tab> to cycle 
through the opened programs until you locate it. 

 
• MapInfo will now present you with your current settings before the copying 

process begins.  If all the statements are correct click on Next>.  If you made 
a mistake click on <Back and re-type the information.   

• The process begins and you are presented with a screen asking you to wait. 
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• Once MapInfo has copied program files it will prompt you to click on Finish to 

complete the process. 

• By clicking on Finish you will have completed the SmartTRAC installation.   

�

�
�

��� ,I�\RX�DUH�LQVWDOOLQJ�D�0LFURVRIW�$FFHVV�%DVHG�3URGXFW�WKH�,QVWDOO�
3URFHGXUH�LV�QRZ�FRPSOHWH���<RX�PD\�RSWLRQDOO\�SURFHHG�WR�WKH�
QH[W�VWHS�WR�VHOHFW�D�GDWDEDVH�ILOH��
�

��� ,I�\RX�DUH�FRQQHFWLQJ�WR�DQ�2UDFOH�GDWDEDVH�\RX�PXVW�LQVWDOO�WKH�
2UDFOH��L�SDFNDJH�DQG�FRQILJXUH�LW�VHSDUDWHO\���3OHDVH�FRQWDFW�
\RXU�6\VWHPV�$GPLQLVWUDWRU�IRU�WKH�FRUUHFW�2UDFOH�DQG�1HW��
FRQILJXUDWLRQ�RSWLRQV��
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Selecting a Database File 
 
If you are running SmartTRAC as part of an Enterprise system on Oracle 
do not attempt to alter database settings, instead go directly to the next 
step (Loading SmartTRAC Workstation). 
 
The following two database files are shipped with SmartTRAC Workstation: 
 

1. STSAMPLE.MDB.  A sample database for use in learning about 
the product.  This is the default selection.  You should use this 
database to learn about SmartTRAC.  

 
2. STBLANK.MDB.  An empty database for use with your fleet.  

Once you are familiar with the product, return to this section to 
see how to change databases.  See also the section Adding & 
Editing Mobile Details for further information on entering your own 
fleet of mobiles. 

 
NOTE: Your systems administrator or SmartTRAC distributor may have 
provided a pre-configured database file for use.  If this is the case; substitute 
that filename for STBLANK when changing databases. 
 
To change the database for SmartTRAC Workstation: 
 

1. Run [Start] Æ [Programs] Æ [SmartTRAC] Æ  
[ODBC Configuration]. You will see the ODBC Administrator. 

2. Click on the "SmartTRAC" User Data Source and click on 
[Configure…].  The current settings for SmartTRAC are then 
displayed. 

3. Click on [Select] and choose the database you wish to use.  
Generally this is STBLANK.  If you have multiple users the 
database may also be located on a network server, where it can 
be accessed by all Workstations. 

 

 
 

 


